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Preface

Welcome to the Oracle Contracts Core, Release 11i. This Concepts and Procedures 
provides information and instructions to help you work effectively with Oracle Contracts 
Core.

This preface explains how Concepts and Procedures is organized and introduces other 
sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

n Technical Service Representatives (TSR)

n Customer Service Representatives (CSR)

n System Administrators (SA), Database Administrators (DBA), and others with similar 
responsibility.

This guide assumes you have the following pre-requisites:

1. Understanding of the company business processes.

2. Knowledge of products and services as defined by your marketing policies.

3. Basic understanding of Oracle and Developer/2000.

4. Background in SQL, PL/SQL, SQL* Plus programming.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation accessible, 
with good usability, to the disabled community. To that end, our documentation includes 
xi



features that make information available to users of assistive technology. This 
documentation is available in HTML format, and contains markup to facilitate access by the 
disabled community. Standards will continue to evolve over time, and Oracle Corporation is 
actively engaged with other market-leading technology vendors to address technical 
obstacles so that our documentation can be accessible to all of our customers. For additional 
information, visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Structure
This manual contains the following chapters:

Chapter 1 Understanding Contracts Core 
This chapter provides overviews of the application and its components, explanations of key 
concepts, features, and functions, as well as the application’s relationships to other Oracle 
applications.

Chapter 2 Using Contracts Core 
This chapter provides process-oriented, task-based procedures for using the application to 
perform essential business tasks. 

Chapter 3 Implementing Contracts Core
This chapter provides the procedures for setting up profile options, lookup codes, and 
Workflow required to implement the integration successfully.

Chapter 4 Customizing Contracts Core
This chapter provides information on adding/removing features and functionality from the 
application. 

Related Documents
Oracle Contracts for Sales Concepts and Procedures 

Oracle Contracts for Service Concepts and Procedures

Oracle Contacts for Rights Concepts and Procedures 

Conventions
The following conventions are used in this manual:
xii



Convention Meaning

    .
    .
    .

Vertical ellipsis points in an example mean that information not directly 
related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that parts of the 
statement or command not directly related to the example have been omitted

boldface text Boldface type in text indicates a term defined in the text, the glossary, or in 
both locations.

< > Angle brackets enclose user-supplied names.

[ ] Brackets enclose optional clauses from which you can choose one or none.
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Understanding Contracts
1

Understanding Contracts Core

This topic group provides overviews of the application and its components, explanations of 
key concepts, features, and functions, as well as the application’s relationships to other 
Oracle applications.

1.1 Contracts Overview
Oracle Contracts Core is designed for any company in any business that requires contracts 
independent of or in support of buying and selling activities.Whether the organization is the 
buyer or the seller, whether it issues contracts or receives them, Oracle Contracts Core 
automates the full life cycle of a contract. 

You can author, execute and control non-industry specific contracts with Contracts Core, for 
both buy and sell contracts. It helps companies manage internal and external obligations, 
control daily deliverables, and be focussed on contractual goals. To ensure that you receive 
everything you negotiated for and provide everything you committed to delivering, Oracle 
Contracts Core helps track "hidden" deliverables enforceable requirements that may not be 
listed as a line item in a contract, but are described in terms and conditions. 

The Contracts Core module acts as a central repository for the collection and dissemination 
of contract information. It contains all data on terms and conditions, deliverables, and parties 
to the contracts. This repository is the key to provide a single source for all the information 
in any contract in your enterprise.

Contracts Core provides foundation functionality that other contracts modules may use, 
including Contracts for Service, Contracts for Sales, and Contracts for Rights. This common 
functionality includes renewing or extending a contract, requesting a contract change, 
managing contract deliverables, and many others. You can record, group, organize, query 
contract data, and set up an automated approval process for your contracts.

Contracts are composed of articles and rules. Articles contain the terms, conditions, and text 
of the contract. Rules are contract terms and conditions with the addition of 
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Contracts Overview
computer-readable formatting that may cause Contracts Core to take action based on specific 
information. Rules are created to control different processes that manage contracts.

1.1.1 New Features
The new features included in this guide:

n Opportunity Integration

n Contracts Auto-numbering

n Events Controller form

n TCA Party Merge

n Price Adjustment Field

n Pricing Upgrade Concurrent Program

n Integration to Oracle Pricing

n Attachment History Maintained

1.1.2 Contracts Integration
Oracle Contracts integrates with the following Oracle modules:

n Contracts for Service

n CRM Foundation (Tasks, Resource Manager, and Interaction History)

n Service (Installed Base Management)

n Order Capture

n Order Management

n Pricing

n Inventory

n Accounts Receivable

n Accounts Payable

n General Ledger

n Human Resources

n Telesales
1-2 Oracle Contracts Core Concepts and Procedures



Launchpad and Navigator
1.2 Launchpad and Navigator 
The main entry points to Contracts are the Launchpad and the Contract Navigator. Contract 
administrators can access notifications, alerts of upcoming deliverables, and the contracts 
repository. This topic covers the following features:

Contract Launchpad

Contract Navigator

Contract Groups

1.2.1 Contract Launchpad
The Launchpad tab is divided into three regions: Inbox, Recent Documents, and 
Bookmarked Documents.

The Inbox displays notifications for contracts that require action.

n Find searches for a contract by status or notification type.

n Open opens a contract selected in the Inbox.

n Respond invokes workflow functions such as approving, signing, or rejecting a 
contract.

The Recent Documents region displays and gives you access to the most recently modified 
documents. Use Bookmarked Documents to maintain your own personal list of contracts.

1.2.2 Contract Navigator
Use the Contract Navigator tab to view contracts by contract groups.

This tab is divided into two sides. The left side displays the contract groups and the right 
side displays the contracts in a grid that belong to the group you select from the left.

From the grid you can right-click to invoke several contract administration functions, or you 
can double-click the contract to get a quick overview of the contract. In addition to the 
overview, double-clicking gives you access to the contract history, schedule, and 
communications.

1.2.3 Contract Groups
Contract groups provide a convenient way to organize contracts using any criteria you like. 
They are similar to folders.
Understanding Contracts Core 1-3



Contract Categories
Create as many contract groups as needed to help you and other users find related 
information about contracts and contract parties. You can use any number of groups to 
classify a single contract and you can nest groups within other groups. 

The groups you create can be public or private. Use public groups to group your contracts in 
a structured way that follows your company or department organization structure or business 
procedures. Use private groups to allow users to group contracts by their personal 
preferences.

If the system administrator gives you the privilege, then you can also create public groups 
that are accessible to all users. Public groups can contain individual contracts as well as 
other public or private groups.

Groups do not permit or restrict access to contracts. For more information see Accessing a 
Contract Group.

1.3 Contract Categories
You can use the authoring window to create and maintain many categories of contracts. 
During setup, categories are created and related to the class of a contract such as Corporate, 
Sales Agreement, Network License, and so on. The class identifies whether the contract is 
core or service. You can tailor the authoring window to suit each category using:

n Line Styles

n Party Roles and Contact Sources

n Rule Groups

n  Status and Operations

1.4 Perpetual Contracts
Contracts enables users to create contracts with end dates and without end dates. A contract 
not having an end date is referred to as a “Perpetual Contract”. As such a perpetual contract 
cannot be extended or renewed, however they can be terminated. Under certain conditions, 
business requirements may provide the need for a perpetual contract. 

Note: A very large number of contracts in a contract group will adversely 
impact performance. You can increase performance by adding subfolders 
and distributing the contract into more subcontracts.
1-4 Oracle Contracts Core Concepts and Procedures



Subcontracts
For example, a company managing customer software licenses may require perpetual 
contract functionality. Because software license agreements last indefinitely, there is no 
reason to apply end dates. Rather the contract effective date is open ended with no end date. 

If you want to make the contract perpetual, simply leave the end date field blank.The 
following business rules apply to perpetual contracts:

n If a non-perpetual contract (“Entered” status) is made perpetual (end date updated), 
effective dates on lines will not be updated.

n If a perpetual contract is made non-perpetual (end date updated), effective dates on lines 
will not be updated

n If a non-perpetual contract is renewed/extended as a perpetual contract, lines will be 
made perpetual.

n If the contract is non-perpetual, contract line(s) cannot be extended as perpetual.

1.5 Contract Index
You can find and examine various components of a contract by using the Contract Index, a 
tree-style structured navigator. By using the contract index, you can follow, access, and 
understand the relationship of contract parts and better understand the context for the 
contract as a whole.

You can select any part of the contract index tree structure and navigate to any appropriate 
tab, row, or column that has the information that you are looking for.

The Contract Index has five display options, or views. With these views of the various 
contract components, you can see some of the hierarchical relationships and certain 
characteristics of the contract such as parties, line items, articles, and rules. The default 
displays the contract view.

For example, you could choose to view the contract rules as the root node. Oracle Contracts 
Core would then show all of the rules for that particular contract. You could then choose to 
see the association that the rule has to the parties, line items, terms, or events of the contract.

If, for example, you wanted to find terms and conditions that were at the line item level and 
that dealt with X, then you could find line item rules, making it much easier and quicker to 
locate the information needed.

1.6 Subcontracts
In order to fulfill the obligations of an existing contract, a party may need to establish a new 
contract with a third party to provide some or all of the items, such as materials or 
Understanding Contracts Core 1-5
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deliverables, required in the original contract. This is called creating a subcontract. These 
subcontracts need to maintain relationships between the components, such as terms and 
lines, of the parent agreement and those of the new contract. You can create a subcontract 
and further specify those articles or rules from the prime contract or master agreement that 
are to flow down to, and be incorporated into a subcontract.

Also, you can create task orders from a master agreement, with the terms and conditions of 
each task order linked from the master agreement. Alternatively, you can simply reference 
other contracts (and by inference, the terms and conditions of those other contracts) without 
specifying any particular details. 

Using subcontracts, you can:

n Subcontract the components into an existing contract or a new contract.

n Maintain data consistency for the subcontracted contract. For example, a subcontract 
would not contain your customer as a customer in the subcontract.

n Select multiple lines or sublines for subcontracting.

n Inherit terms and conditions from higher levels in the hierarchy for the subcontracted 
lines or sublines.

n Reference terms and conditions.

n Modify the copied components.

You can select the lines or sublines and also the components such as parties, articles, and 
rules at the contract header level for subcontracting. After selecting the components, click 
the right arrow button to move them to the right navigator window.

When you create the subcontract, all selected components are copied into the subcontract. 
You can modify the components. You can also select parties to copy to the subcontract, but 
normally this is not useful because the roles change for a subcontract.
1-6 Oracle Contracts Core Concepts and Procedures
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1.7 Status and Operations
An operation is an action you can take with a contract, such as update on line, update via a 
change request, or delete.

The status of a contract is a label defining where the contract stands in its life cycle. 

 Contracts provides the following status types:

n Entered: Contract is currently being edited and it can be completed but not approved

n Signed: Contract is approved, but not yet effective. This status is used, when the 
contract is not yet due, but should have the same protection from changes an approved 
contract has.

n Active: Contract is approved, signed, and effective

n Hold: Contract was set on hold from signed, active, or another hold type. For example, 
use hold when a customer is moving or the contract is in dispute.

n Expired: Contract was active, but is not effective anymore

n Terminated: Contract was active, but was terminated from either side before the 
contract expired

n Canceled: Contract never became active and is not planned to become active

You can define as many statuses per status type as you need. 

You can have a different status on the contract header and on the contract lines. For 
example, you can terminate a single contract line, while the rest of the contract is still active. 

The status of a contract changes a number of ways:

n Manually

n Through the approval process

n Through the extension process

n Through the termination process

n Automatically by the Status Change concurrent program

From the Launchpad you can:

n Initiate a manual status change.

n Extend a contract or contract line.

n Terminate a contract or contract line
Understanding Contracts Core 1-7



Status and Operations
See Using the Launchpad and Navigator.

From the contract authoring window you can submit a contract for approval.

Some status changes have to be done through a concurrent program. For example, the 
program Status Change automatically changes a Signed contract to Active when the start 
date is reached.

1.7.1 User Status
To provide greater control of contract status, you can add custom statuses for any status 
type. For example, to distinguish between entered contracts that are draft and those pending 
approval, you can define draft and pending statuses for the entered status type. For each 
status type, you define the default status that is automatically assigned when a status type 
automatically changes.

1.7.2 Operations
You can control the operations allowed per contract status and category. For each user 
status, you can define the operations that are supported. For example, you can specify that 
draft documents can be updated on line, but contracts pending approval must go through a 
change request process. You can also state that once a contract becomes active it cannot be 
updated at all.

Allowed operations are defined by status, and not by status type. If you define a new status 
for the status type Active, then you must also specifically allow operations for the new 
status, such as on-line update. If you create a new status without specifying any allowed 
operations, then that status allows read only access. 

To set up new statuses and define the allowable operations, see Setting up Status and 
Operations.
1-8 Oracle Contracts Core Concepts and Procedures
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1.8 Access Considerations
You can fine tune access to contracts, such as granting a specific user rights to see a 
contract, but not to modify it. The category definition includes granting access levels to 
responsibilities. For each category you can define whether a given responsibility has read 
only or modify access.

Access to contracts involves the following:

n Contract Group Access

n Allow Operations

n Category Definitions

n Multi-Organization Access

n Restricted Operations

n Troubleshooting Contract Access

1.8.1 Contract Group Access
Your first level of access to contracts is via the contract groups listed in the Contract 
Navigation window. Although you have access to a contract group, you do not necessarily 
see all the contracts in the contract group because other levels of security may be in place.

You can assign one or more contract groups to each contract. There are two kinds of 
contract groups: public and private. A private group is created by a user and only the user 
creating the group has visibility and access to that group. A public group is visible to all 
users.

Public groups can only be created by users that have the system profile option: OKC Public 
Group Creator enabled. If this system profile option is not set or is disabled, then the user 
can only create private contract groups.

Everybody with access to a contract group who is assigned to the contract group has full 
read and write access to the contract, as defined in the Status and Operations window.

Use contract groups to navigate to contracts through different navigation paths. A contract is 
referenced in contract groups, not copied. Assign contract groups in the authoring window in 
the Details subtab of the Summary tab. As a contract administrator, you can use the 
Contracts Groupings window to assign and unassign contracts to groups.
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1.8.2 Allow Operations
The status and operations window defines by category and status which operations can be 
executed against a contract. The allowed operations are defined by status and not by status 
type.

In other words, if you define a new status for the status type Active, then you have to make 
sure that you specifically allow operations such as on-line update. If you create a new status 
without specifying any allowed operations, you implicitly allow no operations for this 
contract status.

1.8.3 Category Definitions
You grant access to contracts using the Responsibilities tab in the Category Definitions 
window. The category definition includes access levels, such as read only or modify, by 
responsibility.

Within a contract, you can grant access to one or many contract groups.

There are a couple of operations and statuses that prevent you from changing a contract. For 
example, while a contract is being changed by somebody else, you cannot access it. While a 
change request is pending approval, you can submit another change request, but your change 
request has to wait for the outcome of the pending change request.

You are restricted in the status changes you can perform on a contract. For example, you 
cannot terminate a contract that was never active. You have to cancel it. You cannot cancel a 
contract that was active.

For a complete list of allowed status changes, see Status and Operations.

1.8.4 Multi-Organization Access
When you log on to Oracle Applications, you automatically sign on within your 
organization. By default, your actions are restricted to read and modify contracts for your 
organization only. For some business uses, where contracts need to be accessed 24 hours a 
day from any organization around the world, contracts need to be accessible outside your 
organization.

If you need to give access to contracts across organizations, you can use the Administration 
subtab in the Summary tab of the authoring window. You grant read only or modify access 
to resources independent of the organization the user is in.

To create a resource, you must choose the CRM Resource Manager responsibility. A 
resource in this context refers to the resource definition of CRM, for example, customers, 
suppliers, employees, and so on.
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If you want to use persons or roles already declared somewhere else in the application setup, 
for example an employee, then you must import these sources using the Import Resources 
function in the CRM Resource Manager responsibility. Make sure you assign contract 
execution rights in the Define Resource menu.

1.8.5 Restricted Operations
Although you have modify access to a contract via your responsibility or access group, you 
may still be restricted from performing certain operations against the contract. You can only 
perform operations that are specified for the status.

If your organization uses changes requests to update a contract and another user is in the 
process of applying a change request, then you will not be allowed to update the contract. 
You can submit another change request while another change request is being applied, but 
you must wait until the prior change request is completed before you can apply your change 
request to the contract.

There are also restrictions for changing the status of a contract. For example, you cannot 
terminate a contract that was never signed, instead it has to be cancelled. You cannot cancel 
a contract that is active, it can only be terminated. See the table of allowed status changes in 
Status and Operations.

1.8.6 Troubleshooting Contract Access 
User does not have access to contract group.

n Check if contract group is public or private.

User cannot see the contract in the contract group.

n Check if the user is in the same organization and has access granted. Check if the user is 
using a responsibility with access to the category.

User can see the contract, but cannot update the contract.

n User was not given access.

n User is using a responsibility with read only privilege instead of modify.

n Operations window excludes that operation or this operation is not included, thus 
implicitly disallowing that operation.

Note: Make sure that you have defined the role completely before importing the 
resource, for example: Define the employee and tie that employee to FND_USER, 
before you import the resource. You can import only once. 
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n The contract may be in a status change that does not allow any operations.
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1.9 Roles and Contact Sources
A contract is an agreement between at least two parties. Each party assumes a role in 
relation to the contract, such as the vendor or the customer. The setup of roles differentiates 
between sell and buy contracts. You can add two or more parties when authoring a contract 
and you can define the party roles and define the sources from within Oracle Applications 
for validating parties.

For example, if you sell goods or services, then you are the vendor and your customer may 
already exist in your customer database (source) as a regular customer.

If you buy goods and services, then you are the customer and your vendor may already exist 
in your vendor database (source). Even though you are the customer in this contract, you 
don’t want to register as a customer in your customer database just to be available as the 
customer in the contract.

In both contracts you have a customer and a vendor each. In one contract you are the 
customer, in the other you are the vendor.

1.9.1 New Roles
In a contract, a role can only be selected if the following conditions are met:

n The category you choose permits the use of that role.

n The role has a valid source. Make sure that the source has a valid date range, the intent 
(sell or buy) matches your contract, and that the source has values.

Once you have defined a new party role or contact role using Define Categories, you can 
select them in the Sources window, where you can assign the sources.

A new party role or contact role will only appear in your contract, if the following 
conditions are all met:

n The role or contact role is defined as a lookup code with a current effective date.

n The role or contact role has a current effective date in the sources window.

n The role or contact role has a source assigned with a current effective date and the right 
intent (buy or sell).

n The source for the role and intent contains at least one value.

n The party role may be needed (for Rules) as well.
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1.9.2 Party and Customer Account Merge Overview
Oracle Contracts subscribes to the Trading Community Architecture (TCA) engine in order 
to utilize the party merge functionality. The Trading Community Architecture enables the 
requirement to merge one party into another when duplicate parties have been identified. 

The Party Merge functionality within the TCA is specifically designed to eliminate duplicate 
data in the Registry layer in order to keep the database accurate. Party information is merged 
to provide a consolidated view. 

Oracle Contracts registration of the entities that reference parties and defining the merge 
procedure allow users to utilize the merge functionality. A batch program runs to determine 
the duplicate party records and merge them accordingly. 

1.10 Line Styles Overview
A contract is composed of lines of text. Control the type of information that can be entered 
on a particular line by defining a line style. The line style sets input requirements and sets up 
the lists of values to choose from in a contract line during contract authoring.

This section covers the following information:

n Top Line

n Sublines

n Pricing

n Line Types and Item Source

n Priced Lines and the Pricing Rule

n New Item Entry

1.10.1 Top Line
Each contract has one or more contract lines. A contract line can be a simple priced item line 
or can consist of several layers of lines and contract items. The most general and least 
detailed line in a contract is called the top line. You can break a top line into sublines and 
multiple contract items to provide a rich level of detail.

To include a top line and its details in a contract, you must include it in the category 
definition. For service contracts, you can define a top line style to be eligible for entitlement 
and invoicing. You define a new line style by selecting the plus sign on the top mode.
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1.10.2 Sublines
Use lines and sublines to group and categorize goods and services. The specific goods and 
services are referenced from your inventory or product catalog as contract items. You can 
use sublines to provide additional detail about the delivery of the contract item. For example, 
a line for a service product includes a subline that defines the level of service contracted for 
that product. A line that represents a licensed product includes a subline that identifies where 
the product is deployed.

1.10.3 Pricing
When creating a line style, you can define it as being a priced line style. You can enter a 
quantity, unit of measure, and unit price. The line automatically calculates the extended 
price and net price. You can enter adjustments to automatically decrease or increase the net 
price. This feature is found at both the line and subline level. See the following table for 
examples:

For each hierarchical path in a line style, you can only price once. You can have multiple 
prices on the same level in a hierarchy.

For example, assume a line style hierarchy such as the following:

Scenario Extended Price Adjustment % Net Price

Initial value $2,400.00 0 $2,400.00

Offer 10% discount $2,400.00 10 $2,160.00

Add 10% surcharge $2,400.00 -10 $2,640.00
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1. You can mark Items 1.1.1.3, Item 1.1.2, Item 1.2 and item 1.3.2 as priced items. None 
of these priced items is a parent or child of another priced item.

2. When you mark the line style for Item 1 at the top line as a priced item, all other 
dependent lines have their price tag removed.

3. Both Item 1.3.2 and Item 1.3.1 can be priced in this example.

1.10.3.1 Recursive Priced Lines
If you define a line style as both Priced and Recursive (select the Recursive check box) this 
will enable this line style to be:

n Priced only at the hierarchy level where the check box is selected 

n Selected at a subline level (however it is only priced for the first instance)

For example, if you define "Product" as a top line as priced and recursive, in the contract 
authoring form then the following names for the top line and sublines maybe displayed:

Top Line: PC Computer (inventory item) $2,000.00

Subline 1: Terminal (inventory item) not priced

Subline 2: Cables (inventory item) not priced
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Subline3: Mouse (inventory item) not priced

For information regarding defining price lists including their limitations to only work with 
inventory items, see the Oracle Pricing User’s Guide.

1.10.4 Line Types and Item Source
For each level in the line style hierarchy, you select a line type and the item source. The item 
source defines the list of values available when authoring a contract that contains the line 
style.

The line styles that can be selected are based on the contract category and line style 
hierarchy.

One special line type is called "Free Format" and is used to enter any text description. It 
does not include an item source. The item source tells you, where you can add values to the 
selection. For example, the source Consulting refers to items in your inventory items with 
the item type Consulting. Similarly, you can add items for the source Media Pack, Self 
SerTraining or Training Line. The source System Item refers to all items in your inventory. 

1.10.5 Priced Lines and the Pricing Rule
Before you enter priced lines in your contract, define the pricing rule group for the contract 
header or contract line. The pricing rule group identifies the price list to be used for your 
priced items. After you identify the price list and when you add priced lines to your contract; 
the list price of the item is retrieved. Based on the quantity you enter on the line, the 
extended price is calculated. This extended price can be overridden in the negotiated price 
column to account for contractual agreements.

1.10.6 New Item Entry
The inventory items list of values is restricted by the organization that is available to the 
contract. When a contract is entered, the organization ID is obtained from the multiorg 
profile option value. The inventory organization value is obtained from the Oracle Order 
Entry system parameters. 

You cannot enter a new item into the individual inventory organizations directly. To enter a 
new item in Oracle Inventory, you enter the item into the master organization. Then you 
copy the item to the individual inventory organizations.
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1.11 Contract Articles
A contract article is the text that describes and details the terms and conditions that are 
attached to a contract. Also see Understanding Contract Rules.

There are two different types of articles: standard and nonstandard.

n Standard articles are referenced from a library of articles. The text of standard articles 
cannot be changed. You still may add variation to an article in a contract.

You can assign releases to articles. When you insert an article into a contract, the 
application chooses the current release.

If you assign incompatibilities to a standard article, then the Quality Assurance check 
detects any incompatible articles in your contract.

n Nonstandard articles are specific to the individual contract. They are either written by 
the author of the contract or copied from the library of articles and modified.

1.11.1 Library of Articles
The library of articles contains standard articles that can be referenced or copied into 
contracts. The standard articles are organized into article sets.

Use article sets to organize articles logically and make them easier to include in contracts. 
You can then drill down to articles from the sets. You can assign price types and categories 
to article sets. When you author a contract, the list of values for the standard articles are 
filtered by the assigned price types and categories.

You can translate article sets into rules. When an article set is referenced or copied into a 
contract, the associated rules are also copied into the contract. 
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1.12 Attachments
Contracts enables you to attach documents to a contract at the following: 

n  Contract Header

n  Contract Line

n  Standard Articles

These attachments are supported when: 

n A contract or contract line is copied to a new contract 

n A contract is renewed 

n A contract is versioned. 

When a contract is versioned the attachments history can also be maintained. Maintaining 
different versions of attachments provides an audit trail which could be useful during 
negotiation. 

A contract is linked to an attachment by Contract ID (ID is the surrogate key for a Contract 
Number and Contract Number Modifier). With this feature, attachments are linked to the 
Contract ID and the major version for the contract. As a result, when a contract is versioned, 
the new version will have attachments that are a copy of the attachments attached to the 
previous version. All the subsequent changes to existing attachments or addition of new 
attachments will be relevant to the current version of the contract.
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1.13 Contract Rules
This section defines contract rules and explains how they are used in Oracle Contracts Core. 
Because rules are what trigger many functional processes within contracts, it is essential that 
they be clearly understood. This section covers the following subjects:

n What a Rule Does

n Difference Between Rules and Articles

n Conditions and Rules

n Tracking Deliverables with Rules

n Rule Groups

n Object and Subject

n Where Rules Can Be Used

n Quality Assurance and Rules

1.13.1 What a Rule Does
Rules are the terms and conditions of a contract. Contracts can trigger other application 
processes by using the computer-readable, formatted rules. Create rules to control different 
processes that manage contracts. Use billing rules, for example, to determine when and how 
a bill should be sent. Oracle Contracts Core contains a preset list of rules.

1.13.2 Difference Between Rules and Articles
Rules are contract terms and conditions with the addition of computer-readable formatting 
that cause Oracle Contracts Core to take action based on the information. Articles are the 
textual presentation of rules.

When you put an article into Oracle Contracts Core, that article represents text. With a rule, 
however, you can initiate functions within the application. For example, an article states that 
a confirmation letter must be sent within three days of the signature date. When this 
information is entered as a rule, a notification for a confirmation letter is generated.

1.13.3 Conditions and Rules
You can use conditions and rules together or you can use each component individually. 

A condition is part of the events concept: 

n A condition is the combination of actions, condition lines and outcomes. 
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n When combined with a rule, a condition does not require an outcome. 

n Condition lines are always optional. 

With conditions you can capture contract events, like the signing or expiration of a contract. 
You can use condition lines to filter, if an outcome is executed. For example, you can define 
that a quote is automatically created 5 days prior to the expiration of a contract, if the 
contract total does not exceed $50,000.00. 

With the notification rule, you can schedule a generic notification, that does not use a 
condition like the expiration or the initiation of a change request. For example, You can 
define that the project leader is notified every other week to schedule a status meeting for the 
following Friday. 

Using rules and conditions together, you can base the notification on conditions. For 
example, You can send a notification to the project manager, each time a change request is 
initiated. The notification is not sent, if it was initiated by the project manager. In this 
example, you would integrate a contract specific condition in the notification rule. The 
condition would identify the change request initiation and filter, if the requester of the 
change request is the project manager herself. 

1.13.4 Tracking Deliverables with Rules
Rules capture additional information you want to store for a contract. You can group rules 
into rule groups that help to enforce business processes and company standards.

A schedule rule captures date information to help you manage deliverables. Schedule rules 
store point-in-time specifications that can be used with events. An example schedule rule is 
“drug-free certification must be provided within 30 days of contract signing.” In other 
words, rules can capture information about dates or future dates that are not known at the 
time a contract is authored. Schedule rules can represent date driven, event, or periodic 
phrases such as these: 

n Date driven: First Monday of every month

n Event: After the contract is signed

n Periodic: Every 6 months, every week

For more information, see Schedule Rules.

Note: If the condition lines do not offer you the attributes you need for filtering, 
then you can use the process definition to register a PL/SQL function to return 
true or false. For more information on registering a function, see Defining a 
Process. 
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1.13.5 Rule Groups
A rule group contains one or many rules. Rules collect one or many related pieces of 
information. Rules are stored in a formatted way as opposed to free text like articles.

Your company can choose to assemble rule groups and make some rules optional. Once you 
have selected a rule group, you can see if the rules contained are optional.

Assign rule groups to your contracts according to your business procedures.

You can save incomplete data, but all required rules have to be complete to pass Quality 
Assurance.

Rules with similar characteristics are grouped so that you can easily reference and access 
them. For example, create a rule group for billing which would group together rule types 
such as Bill-To, Schedule Billing, and Payment Terms.

1.13.6 Object and Subject
When you define categories or you create a contract, you may encounter situations, where 
the role of a contract party may be obvious. However, the system may not be able to identify 
which of the parties or party roles should be displayed in a list of values. 

For example where you have: 

n Multiple parties for a specific role (more than 1 customer in a syndication agreement) 

n Multiple roles, that only have slight differences (customer and customer agent) 

The subject is the acting party, the object is the party being acted upon. For example, the 
billing rule would need to know who (the subject) bills whom (the object). 

The concept of object/subject is considered in two situations: 

n Defining a category 

n When authoring a contract and adding/changing rules 

Not all of the rules need the concept. When you enter a rule, where none of the parties is 
ever displayed in a list of values, the subject/object concept is irrelevant such as the currency 
rule group, notify rule group, renewal rule group, and so on. Therefore you cannot enter a 
object or subject in the fields for such rules. 

When you assign rules to a category, you may have to add the roles to the setup, when the 
rule group requires it. If that setup step is missing, then the authoring form will notify you of 
the incomplete setup of the category, when you try to use the rule group in question. 
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For the example given above, when you add the billing rule to a category, you would have to 
identify that the customer role and not the customer agent role should be subject of the 
billing rule group. 

When you author a contract, you may have more than one customer, for example when you 
record the contract for a syndicate. In that case, the party roles field allows you to identify, 
to which of the customers the invoice is sent. Once you have identified the right customer, 
then you can select the from correct billing addresses. 

1.13.7 Where Rules Can Be Used
Rules can be put into use in three different places:

n Contract header

n Contract line

n Article sets

1.13.8 Quality Assurance and Rules
Each rule can consist of one or more fields. One or more fields can be required entries. You 
can only add rule groups and not single rules to a contract. Quality assurance enforces 
required fields. The quality assurance checklist check a contract to help ensure specific items 
have been completed. You can create your own quality checks by defining a QA Checklist. 
See the procedure for Defining a Quality Assurance Checklist.

The optional check box in the rule groups impacts the required fields of a rule in the 
following ways: 

n If you make a rule in a rule group mandatory, then the required fields of a rule must be 
entered.

n If you make a rule in a rule group mandatory, but there are no required fields, then 
Quality Assurance passes.

n If you make a rule in a rule group optional, with all fields nonrequired, then Quality 
Assurance passes.

n If you make a rule in a rule group optional, then the required items are only enforced if 
at least one field of the rule was entered. If you don’t enter anything for a rule, the 

Note: You need to identify the object and subject, even if there is only one 
eligible candidate. 
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mandatory fields are not enforced. You will experience this only in very exceptional 
cases.

In addition to rules with nonrequired fields, Quality Assurance can enforce dependencies or 
alternatives. For example, in a prepayment rule, you either have to enter an amount or you 
have to enter a percentage, but neither of the fields are mandatory. In this case, the Quality 
Assurance check will result in an explanation of why the rule did not pass.

1.14 Contract Events
Use events to automatically initiate actions such as creating a service request, sending a 
notification, and creating a task. Events occur as a result of something happening or before 
an upcoming event.

In other words, an event acts upon phrases such as:

n When this happens, do something

n At a certain point in time, something happens

The “when something happens” or “at a certain point in time” are actions, and “do 
something” is an outcome. 

The action can be qualified by conditions. For example, it may not be whenever something 
happens, but whenever something happens and some conditions are met.

In summary, events are composed of actions, conditions, and outcomes.

Events allows synchronous and asynchronous processing. The asynchronous processing 
takes advantage of the advanced queuing method. That is, you do not have to wait until an 
event is evaluated and all the outcomes are executed to continue with your activities. On the 
other hand, due to the type of business, some applications such as Relationship Plan require 
an immediate event evaluation while you are using the application.

This topic covers the following:

n Types of Events

n Conditions

n Types of Condition Lines

n Types of Conditions

n Outcomes

n Schedule Rules

n Renewal Rules
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1.14.1 Types of Events
You can handle action-based events and date-based events.

Action-based events are predefined actions that occur in the application. Examples of 
action-based events are contract signed, contract terminated, counter updated, and change 
request initiated.

Date-based events are dates of significance within the application. For example, the contract 
expiration date.

You define action-based events and date-based events using the Actions window. In this 
window you also define action attributes that can be used further in conditions and 
outcomes.

1.14.2 Conditions
You use conditions to define additional criteria for an action-based event or for a date-based 
event. The conditions also specify the outcomes that need to be initiated when the condition 
evaluates to true.

Condition lines qualify action and date-based events. They are used to specify that an 
outcome is to be initiated not only when the action happens, but also when the action 
happens and certain conditions are satisfied. For example: “when the contract is signed and 
the amount of the contract is greater than $100,000,” or “30 days before contract expiration 
and when the contract category is network license agreement.” It is not required to define 
condition lines for a condition.

1.14.3 Types of Condition Lines
There are three types of condition lines: expressions, counters, and functions.

Using expressions, you can define simple comparisons using the operators such as <, >, =. 
Expressions are always based on action attributes.

Counter condition lines are applicable for Oracle Contracts for Service and Installed Base. 
You define conditions for a particular counter reaching a value. Counters can be defined for 
a product or for a service. For example “when the number of photocopies for a photocopier 
is greater than 1,000,” or “when the number of calls made by a customer in a gold service 
agreement is over 10."

Functions can be used for more sophisticated criteria that can be addressed using PL*SQL 
procedures. A function accepts one or more parameters and returns true or false after its 
evaluation. Functions don’t need to be based on action attributes.
Understanding Contracts Core 1-25



Contract Events
1.14.4 Types of Conditions
There are two types of conditions:

n Independent conditions

n Conditions attached to contracts

Using condition templates, you can define multiple samples of conditions. From a template 
you can define either an independent condition or a condition to be attached to a contract.

Independent conditions are not owned by any object. Whenever an action occurs, regardless 
of the contract, the outcome is initiated if the condition evaluates to true. For example, 
“whenever any contract is signed create a task to notify the contract administrator.”

Conditions can be specific to contracts. Depending on the action, a condition can be related 
to a contract line or to a contract as a whole. For example “when the contract is signed” 
relates to the entire contract, and “when the contract line is terminated” relates to a line of 
the contract.

1.14.5 Outcomes
An outcome is an automated process that performs a task such as initiating a service request 
workflow or sending a notification. When the condition is true, the outcomes associated with 
that condition are performed. 

An outcome is initiated using Oracle Workflow. For versions prior to 11.5.3 the profile 
option "OKC: Success Message Recipient" is setup to notify a recipient of a successful 
outcome. Oracle Workflow has the capability of notifying a recipient of the success or 
failure of an outcome. The recipient can be the same person for success and failure or you 
can select a different person for both. For example a contracts administrator maybe selected 
as the success recipient and a system administrator is selected as the failure recipient. 

Before an outcome can be associated with a condition, it must be defined using the Process 
Definition window. There are four types of outcomes: workflow, PL/SQL procedure, alert, 
and script. Workflow and PL/SQL procedure are outcomes. Alerts are synchronous 
outcomes. 

You cannot use script for outcomes. Script is not referring to a SQL script. Script is only 
valid for the type of "outcome" to support Relationship Plan functionality as a synchronous 
event. 
1-26 Oracle Contracts Core Concepts and Procedures



Renewal Rules
1.15 Schedule Rules
Schedule rules indicate that some deliverable is due at a future date or time that is not known 
at the time of authoring the contract. For example, "product" documentation must be 
provided within 30 days of contract "signing." Rule groups that contain schedule rules also 
contain a notification rule so that you can create tasks for the schedule rules. You can view 
schedule rules in the task manager.

You can use the following types of time in a schedule rule:

n Absolute: The point in time is defined by absolute values and is expressed as a date and 
time value. An example is January 15 at 9 a.m.

n Conditional: The point in time is when something happens or after something happens. 
Examples include "10 days after contract signing" and "upon contract expiration." A 
schedule rule can also be based upon contingent events, such as "injury accident" or 
"earthquake."

n Generic: The point in time is a day of the month or day of the week. Examples include 
"every first Monday at 10:00 a.m." and "the third Wednesday of June."

n Recurring: The point in time that reoccurs at intervals, such as every 6 months or every 
30 days.

You can view scheduled events for a contract in the contract navigator. If you created tasks, 
then you can also use the administration windows in the Task Manager.

1.16 Renewal Rules
You can use the rules to determine the behavior of contracts and lines when a contract is 
renewed. 

At the contract level you can choose between the following options: 

n Active contract: The renewed contract is automatically approved. 

n Do not renew: The contract cannot be renewed. 

n Notify Salesrep: The renewed contract is in entered status and the salesrep is notified, to 
review the contract and negotiate the terms and conditions before submitting for 
approval. To find a Renew Contract notification in your Inbox, click the Find button in 
the Inbox region of the Launchpad tab window. Select "Open" for Status and for the 
Notification Type select "Contract Alert" for notifications identifying renewed 
contracts. 
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n Submit for Approval: The renewed contract is in entered status, the contract is 
automatically submitted for approval and the salesrep is notified. 

On the contract line level, you can determine the line level behavior when a contract is 
renewed: 

n Do not renew: The renewal process does not renew this line when renewing the 
contract. 

n Keep duration: The renewal process does not adjust the effective date range of the line, 
if the renewed contract has a longer duration than the originating contract. 

n Full duration: The renewal process adjusts the line duration to the duration specified in 
the contract header. 

For each line, you can override the renewal rule type. For example, while the entire contract 
may specify that all lines are adjusted to full duration, a rule on the line level may specify to 
exclude a certain line from the renewal process. 
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2

Using Contracts Core

This topic group provides process-oriented, task-based procedures for using the application 
to perform essential business tasks.

2.1 Using the Launchpad and Navigator
Contracts are launched from the Navigator window. This is the first window that appears 
after you have accessed the application. This window has a Functions tab and Documents 
tab. The Functions tab displays the major application functions such as Launch Contracts, 
Contract Groups, Setup, and so on. The Documents tab enables you to create and display a 
list of documents that are easily accessible.

The function “Launch Contracts” is selected as a default. When you click Open the Oracle 
Contracts window appears having two tabs:

Launchpad

Navigator

2.1.1 Using the Launchpad
Within the Oracle Contracts window the Launchpad tab is divided into three regions: Inbox, 
Recent Documents, and Bookmarked Documents.

The Inbox displays notifications for contracts that require action.

n Find searches for a contract by status or notification type.

n Open opens a contract selected in the Inbox.

n Respond invokes workflow functions such as approving, signing, or rejecting a 
contract.
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The Recent Documents region displays and gives you access to the most recently modified 
documents. Use Bookmarked Documents to maintain your own personal list of contracts.

2.1.1.1 Using the Inbox
When you press the right mouse button (within the Inbox) a list of functions are displayed in 
a pop-up menu:

n Copy Cell

n Copy Selected Rows

n Copy All Rows

n Find in Table (Find Launch Inbox window)

n Refresh

n Sort

The copy functions enable you to paste the cells to Excel spreadsheet or Word. It keeps the 
table format which means that you can copy the entire navigator to Excel. Using the Sort 
window you can sort contracts in any order you like such as Date, Priority, Status, and so on.

To find a contract in the Inbox, you can either scroll the list of contracts and select a contract 
or search contracts by status or notification type then execute a search using the Inbox Find 
window. 

Steps

Finding a Contract with the Inbox Find Window
1. From the Navigator, choose Launch Contracts (B) Open > (T) Launchpad.

2. Click Find. The Inbox Find window appears.

3. Select Contract Status from the LOV.

4. Select Notification Type from the LOV.

5. Click Find. Contracts matching your search criteria appears in the Inbox.

Responding to a Contract
6. Select a contract in the Inbox.

7. Click Respond. This launches a Workflow window.

8. Perform the necessary Workflow functions. After updating in workflow the new 
contract status is shown in the Subject column.
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Opening a Contract
9. If necessary, select Refresh by pressing the right mouse button from within the Inbox.

10. Select the contract in the Inbox.

11. Click Open. The Contracts Authoring window appears allowing you to browse or 
update the contract.

2.1.1.2 Opening a Contract in Recent Documents
When you do a mouse right-click (within Recent Documents) a list of functions appear in a 
pop-up menu. These are the same functions (See, Using the Inbox) as in the pop-up menu 
for the Inbox. 

Steps
1. From the Navigator, choose Launch Contracts (B) Open > (T) Launchpad.

2. If necessary, select Refresh (within Recent Documents).

3. Select a contract or when there are many contracts, use “Find in Table”.

4. Click Open. The Contracts Authoring window appears allowing you to browse and 
update the contract.

2.1.1.3 Bookmarking a Contract

Steps
1. From the Contracts Authoring window, select Actions > Bookmark. A Note window 

appears with a message confirming the Bookmark.

2. Click OK.

3. Navigate to Oracle Contracts (T) Launchpad.

4. If necessary, select Refresh (within Bookmarked Documents).

5. Select (or use Find in Table) your contract in Bookmarked Documents.

6. Click Open.The Contracts Authoring window appears allowing you to browse and 
update the contract.

7. If you want to remove a contract from the list, select the contract and click Remove.
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2.1.2 Using the Navigator
Within the Oracle Contracts window, you can use the Contract Navigator tab to access a 
variety of functions related to finding, creating, viewing, and managing contracts. From the 
Navigator tab (in the right pane) you can press the right mouse button and a pop-up menu 
appears showing these functions (in addition to the same functions from the pop-up menu in 
Launchpad). You can also access the same functions from Tools on the menu bar: 

New

– Before authoring a contract, you must create it first using the Create a New 
Contract window.

Open

– Right-click a contract from the Contract Navigator to open the Contracts Authoring 
window.

Create New Version 

– You can create a new contract version by selecting a contract and pressing the right 
mouse button.

Create Change Request

– Change Requests enable you to document changes to a contract and submit for 
approval.

Copy

– You can copy a contract or parts of a contract using the Copy window.

Subcontract

– You can copy a contract or parts of a contract to create a subcontract using the 
Subcontract window.

Renew

– Using the Renew Contracts window, you can renew an existing contract.

Change Status 

– Using the Contract Status window, you can change the status of a contract.

Extend

– Using the Extend Contracts window, you can extend the end date for a contract.

Terminate
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– An active or on hold contract can be terminated using the Terminate Contracts 
window.

Execution

– Selecting Execution provides you with an overview of a selected contract and 
access to the History, Schedule, Communications, and Related Objects tabs. 
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2.2 Creating a Contract
Follow these procedures to:

n Create a new contract 

n Create a contract from a template

n Create a contract template

2.2.1 Creating New Contract

Prerequisites
None

Steps
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window appears.

2. In the Contract Navigator tab, right-click and choose New. The Create a New Contract 
window appears.

3. Select Create a new Contract Manually.

4. Select a Category from the LOV. Make sure you select the proper category for contract 
type such as, Corporate Contract for Contracts Core.

5. Click Create. The Contract Authoring window appears. You are now ready to author 
the contract. Go to Authoring Contracts.

2.2.2 Creating a Contract from a Template
Use this procedure to create a contract from a template.

Prerequisites
A contract template must be created see, Creating a Contract Template.

Steps
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window appears.

2. In the Contract Navigator tab, right-click and choose New. The Create New Contract 
window appears.

3. Select Create a Contract from a Template.
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4. Select a template from the LOV, or if you need to search for a template, then:

a. Click Find.

b. In the Search Templates Window enter the search criteria.

c. Select a template.

d. Click Open.

5. Click Create. The Contract Authoring window appears. You are now ready to author 
the contract. Go to Authoring Contracts.

2.2.3 Creating a Contract Template
Use this procedure to create a contract template.

Prerequisites
None

Steps
1. Navigate to the Contracts Authoring window.

2. Enter a contract number to identify the template.

3. Select a Buy or Sell for intent. 

4. Enter an end date.

5. In the Details subtab, enter at least one group name.

6. Navigate to Actions > Save as Template.

7. Enter the Template Name and optionally the Adjustment.

8. Click OK.

Guidelines
In some situations you may open an existing contract and save it as a template. 

When you open a template within the Contract Authoring window you see Template Name 
as a field instead of Contract Number. You are now ready to use the template. Go to 
Authoring Contracts.
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2.3 Opening a Contract
Use this procedure to open an existing contract. 

Prerequisites
None

Steps
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window appears.

2. In the Contract Navigator tab, select a contract group.

3. Right-click a contract and choose Open. The Contract Authoring window appears. You 
are now ready to browse or update the contract. Go to Authoring Contracts.

2.4 Creating a New Version
Use this procedure to create a new version of a contract. Subsequent versions can be viewed 
from the History tab within the Contract Execution window. 

Prerequisites
None

Steps
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window appears.

2. In the left window of the Contract Navigator tab, select a contract group.

3. Right-click a contract and choose Create New Version. This creates a new version of 
your contract.

Guidelines
When you create a new version, the digit in front of the period (the main version), is 
increased by one. The minor version is reset to zero.
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2.5 Creating a Change Request
Change Requests are a formal way to document changes to a contract. A request is approved 
by the approver defined in the workflow selected and submitted for the change request. 
Once your change request is approved, the administrator entered in the change request 
receives a notification that the contract can be changed.

An internal key gives the change request administrator update access to the contract. When 
the administrator changes, it is locked for other change requests until the change request is 
closed. See Applying Changes and Closing the Change Request.

Prerequisites
The status and operations must allow changes for that category and status.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select the contract you want to change.

3. Right-click the contract and choose Create Change Request. The Create a Change 
Requests window opens. 

4. Enter the request name and a description.

5. Enter the requester’s name. This person will receive a workflow notification when 
changes have been approved and can be applied to the contract.

6. Enter the request date and effective dates.

7. If you want to version the changed contract, then select Version.

8. If you want to have a signature required, then select Signature Required.

9. Record the lines where you are requesting a change and the exact nature of the change.

10.  Select the Admin tab.

11. Select the Approval Workflow.

12. Select Party Approvals.

13. Click Submit for Approval. 

2.6 Approving, Applying, and Closing Change Request
The change request must first be approved before the contract can be changed. After the 
change request has been approved, you can open the contract and apply the changes as 
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described in the change request notification. Once you start editing the contract, you 
automatically lock the contract for other users with an approved change request.

Prerequisites
In order to apply changes, the change request notification must still be open in your inbox. 
No other change request must be in process.

Steps

Approving Change Request
1. From the Navigator, choose Launch Contracts.

2. From the Launchpad, find the Change Request Approval (assuming the approval 
workflow routed the change request approval to you, otherwise switch users).

3. Select the contract from the Inbox and click Respond. 

4. Click Approve.

5. Requery the Inbox to ensure the Change Requests is Approved for the specific contract. 

Applying Changes
6. In the Launchpad tab, select the approved change request notice in your inbox and click 

Open. The Contract Authoring window appears (the status of the contract should be QA 
Hold).

7. Edit the contract according to the approved changes.

8. Save and close the contract.

Closing Change Request
9. In the Contract Navigator tab of the Oracle Contracts window, select the contract you 

changed (make sure you have refreshed the window).

10. Double-click the contract. The contract window appears.

11. (N) (T) History (T) Admin.

12. Click Check Contract. QA should be successful and you should receive a "Please 
Acknowledge" note.

13. From the Contract Navigator, requery the contract. The contract status should be 
active and released the lock on the contract.
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2.7 Changing the Status of a Contract
Use this procedure to change the status or status type of a contract. The contract status 
determines the operations allowed in the contract and status type.

In the following table, auto means that the concurrent program Status Change automatically 
changes the status when the conditions for a status change are met.

Prerequisites
None

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Right-click a contract and choose Change Status. The Contract Status window appears.

4. Select the new status from the list of values.

5. Close Contract Status window and save your changes.

References
 Status and Operations

Status to 
From

Entered Signed Active Hold Expired Terminated Canceled

Entered Yes Yes/

through 
approval

Yes/ 
through 
approval

No No No Yes

Signed No Yes Yes/auto Yes Yes/

auto

Yes No

Active No No Yes Yes Yes/

auto

Yes No

Hold No Yes Yes Yes Yes No No

Expired No No Yes No Yes No No

Terminated No No No No No Yes No

Canceled No No No No No No Yes
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2.8 Copying a Contract
There are several ways to copy a contract, parts of a contract, or multiple contracts.

Prerequisites
None

Steps
1. Navigate to the Copy window using one of the following ways:

n In the Contract Navigator, select a contract group, right-click a contract, and 
choose Copy.

n Open an existing contract, and in the Authoring window, choose Copy from 
Contract/Template from the Action menu.

2. In the Copy window, enter the new contract name, and optionally, a contract 
adjustment.

3. From the left side, select the contract or part of the contract you want to copy.

4. Click the double right-arrow button to move the existing contract or parts on the left 
side to the right side. Anything on the right side is considered part of the new contract. 

5. Optionally, click the double left arrow button to move a new contract or parts of a 
contract back to the existing contract area on the left side. 

6. Click Create.

Your new contract with copied contract information is now saved. You can then make 
changes to the newly created contract in the same way that you would when authoring a 
contract.
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2.9 Creating a Subcontract
In order to fulfill obligations of an existing contract, a party can establish a new contract 
with a third party to provide some or all of the items (such as materials or deliverables) 
required in the original contract. This is called creating a subcontract. You can copy a 
contract or elements of a contract into a subcontract. Use this procedure to create a 
subcontract.

Prerequisites
An active contract must be in place.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Right-click a contract and choose Subcontract. 

4. On the right side, enter the name and optionally a modifier for the new contract.

5. Select a category for the new subcontract.

6. Select the Intent.

7. Select the Perspective.

8. If you want to reference to the subcontracting contract instead of copying components, 
then select Keep References. You cannot change referenced components in the new 
subcontracted contract.

9. Highlight the desired components in left navigator, click the forward arrow button and 
click Create in the subcontract components selection pop-up menu.

You can make changes to the new subcontract in the Contract Authoring window.

References
Defining Sources

Authoring Contracts
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2.10 Renewing a Contract
Renewing a contract does not affect the current contract. It creates a new contract by 
copying the current contract. You can renew a contract only once. For more information see 
Renewal Rules.

For example: You can renew contract A100-2000 and create the renewed contract 
A100-2001. Then you cannot renew the contract A100-2000 again, but you can renew 
contract A100-2001 into contract A100-2002.

Prerequisites
The contract must be in active, signed, or expired status.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Select one or more contracts, right-click, and choose Renew.

4. To keep the new contract distinguishable, the modifier is defaulted to the value you set 
in the profile option OKC: Renewed Contract Identifier, with the current date appended. 
You can change the modifier to another value.

5. If the renewal is for a non-perpetual contract, the new start date is defaulted to the date 
following the end date of the current contract. Either select an end date for the renewed 
contract or enter values for duration and period. For example, to renew a contract for six 
months, enter 6 in the duration and select Month in the period field.

6. If the renewal is for a perpetual contract, select the Perpetual check box.

7. Click Renew. A copy of the current contract is saved.
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2.11 Extending a Contract
Use this procedure to extend a contract. Extending a contract changes only the date a 
contract is scheduled to expire and possibly changes the status of the contract and lines from 
expired to active. You can also extend a contract line, see Extending a Contract Line

Prerequisites
The contract must have a status of Active or Expired.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Select one or more contracts, right-click, and choose Extend. The Extend window 
appears.

4. If the extended contract is non-perpetual, either select a new end date for the contract or 
enter values for duration and period. For example, to extent a contract for a further six 
months, enter 6 in the duration and select Month in the period field.

5. If the extended contract is to be perpetual, select the Perpetual check box. The lines will 
also be perpetual. 

6. Click Extend.

2.11.1 Extending a Contract Line
Use this procedure to extend a line on an active contract. Extending a line may change the 
end date of a contract. When the extended line then is scheduled to expire on the new end 
date and if applicable, adjusts the end date of the contract.

Prerequisites
The contract line must have a status of Active or Expired.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Double-click a contract to see the overview.

4. Select the line or lines you want to extend.
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5. Right-click and choose Extend. The Extend window opens.

6. Either select a new end date for the line or enter values for duration and period. For 
example, to extent a contract line for further six months, enter 6 in the duration and 
select Month in the period field.

7. Click Extend.

Guidelines
If you extend a contract line beyond the end date of a contract, the end date of the contract is 
automatically updated to the end date of the extended line.
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2.12 Terminating a Contract
Use this procedure to terminate a contract that is active or effective and on hold. You can 
also terminate a contract line, see Terminating Contract Lines.

Prerequisite
The contract must have a status of Signed, Active, or Hold.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Select one or more contracts, right-click, and choose Terminate. The Terminate 
window appears.

4. Enter a termination date and a termination reason.

5. Click Terminate.

Guidelines
If you want to add more reasons for a termination, your system administrator can add more 
options in the Lookup Codes.

2.12.1 Terminating Contract Lines
Use this procedure to terminate a contract line in an active contract. If you want to add more 
reasons for a termination, your system administrator can add more options in the Lookup 
Codes.

Note: For most terminations the Contracts Core termination form is 
used. However when using Contracts for Service with the contract class 
“Service” a Contracts for Service “Terminate Contracts” form is used. 
This form displays the amount to be credited with an option to override 
this. After performing the processing for credits, Contracts for Service will 
call the Contracts Core terminate API.
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Prerequisites
The contract status is Active and the contract lines have a status of Active or Hold.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Double-click a contract to see the Overview.

4. Select the line or lines you want to terminate.

5. Right-click and choose Terminate. The Terminate window appears.

6. Enter a termination date and a termination reason.

7. Click Terminate.

Note: For most contract line terminations the Contracts Core 
termination line form is used. However when using Contracts for Service 
with the contract class “Service” a Contracts for Service “Terminate 
Contract Lines” form is used. This form displays the amount to be credited 
with an option to override this.
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2.13 Executing a Contract
You can get an overview of a contract by selecting it from the Navigator tab and double 
clicking or by selecting New from the pop-up menu. A window appears having four tabs.

Overview

History

Schedule

Communications

Related Objects

2.13.1 Administering the Contract
The Overview tab enables you to view the contract, update the contract, extend (See, 
Extending a Contract Line), or terminate a contract line (See, Terminating Contract Lines). 

Opening the Contract for Update

Steps
1. From the Contract Navigator tab, select a contract.

2. Double click the contract. The contract window opens.

3. Select a contract line.

4. Right click the contract line and select Open. The Contracts Authoring window 
appears.

5. Click Open for Update. Contract Status changes to QA Hold.

6. Enter your updates. 

7. Click Check Contract.

8. Review QA Results.

2.13.2 Viewing the History of a Contract
Use this procedure to view older versions of a contract. 

Prerequisites
None
Using Contracts Core 2-19



Executing a Contract
Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Double-click the contract for which you want to see a previous version. A summary 
window appears.

4. Select the History tab. 

5. In the Select list, select Contract Versions to see all versions. All major versions are 
displayed.

6. Select the version you want to open.

7. Click Open. You now can view a previous version of the contract.

2.13.3 Updating the Schedule
Use this procedure to view scheduled events, update completed events, and record 
contingent events.

Prerequisites
None

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select the contract for which you want to see scheduled 
tasks or completed outcomes.

3. Double-click the contract and then select the Schedule tab.

Viewing Events
4. Select a Start Date (or you can leave blank) from the LOV.

5. Select View from the LOV (such as All Tasks, Completed Tasks, and so on).

6. Click Refresh. 

Changing Event Status to Complete
7. Repeat steps 4-6.

8. Select Event.
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9. Click Complete. The Record Task Completion window appears. 

10. Select Actual Date from LOV.

11. Click OK.

12. Click Refresh. The Status for the selected event should indicate Closed.

Recording a Contingent Task
13. Select a Start Date from the LOV.

14. Select for View “Contingent Tasks” from LOV.

15. Click Contingent. The Record Contingent Task Event window appears.

16. Select Event Type from LOV.

17. Select Occurrence Date from LOV.

18. Select Task Owner from LOV.

19. Click OK.

20. Click Refresh. The task appears.

2.13.4 Recording Communications
The Communications tab allows you to record and view communications between any two 
parties... not necessarily the contract parties. The following party roles can be involved:

n Party Contacts and Employees (Sell contract)

n Employees and Employees (Both)

n Supplier Contacts and Employees (Buy contract)

 Any resource can be involved in the communication. These interactions should be possible 
irrespective of the status of a contract. Such communications can range from phone calls and 
e-mails to formal letters sent. You can use the attachments feature to attach files or e-mails 
to communications. 

Prerequisites
Action Items and Outcomes must be setup in Interaction History. From the file menu, select 
Switch Responsibility > CRM Administrator > Interaction History Administration.

Resources involved in the communication have to be registered in Resource Manager. From 
the file menu, select Switch Responsibility > CRM Administrator > Resource Manager 
> Maintain Resources > Import Resources.
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Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select the contract for which you want to see or enter 
communications.

3. Double-click the contract and select the Communications tab.

4. Click Create. The Communication Details for XXXX (Contract Number) opens.

5. Select a Communication Type.

6. Select a Start Date.

7. Select Agent Name.

8. Select Party Role.

9. Select Action Item.

10. Select Outcome.

11. Enter Subject.

12. Enter additional information in Details.

13. Click OK.

2.13.5 Viewing Related Objects
This tab enables you to view contact quote and order details within Order Capture.

Steps
1. Select Related Objects tab.

2. Select contract details to review.

3. Click Details.
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2.14 Finding Contracts
Follow this procedure to find a contract when you do not know which group the contract is 
associated with. Using the Search Templates and Contracts window you can enter search 
criteria and execute the search. When the search is completed, a list of contracts should 
appear in the Results region. Select a contract and right click to open the contract.

Steps
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window appears.

2. From the View menu, select Find. The Search Templates and Contracts window 
appears.

3. Choose your search criteria using one or more of the following fields:

n Contract Number (Modifier cannot be entered it is only populated from the LOV)

n Category

n Status

n Start Date/End Date

n Group (within the Select region)

n Party Role: This field must be populated before using the following:

– Intent 

– Party Name 

– Contact Role

– Contract Name

4. Click Search.

5. Select your contract from the Results region and right click to open the contract.

Guidelines
For avoiding a long query time, you should enter either a contract number, party name, or an 
end date range.
Using Contracts Core 2-23



Authoring Contracts
2.15 Authoring Contracts            
The Contracts Authoring window is where you create and modify contracts. You can 
perform the following functions:

Entering General Information

– The types of information you enter includes contract number, intent, duration, and 
contract group.

Entering Summary Information

– You can select approval workflow, QA Checklist, and assign access to groups or 
users.

Entering Parties and Contacts

– You select the parties and the individuals involved with the contract.

Specifying Line Items 

– Using the Line Items tab, you specify the contract deliverables and relevant items.

Entering Articles

– An article is the text that you attach to a contract which defines the terms and 
conditions.

Entering Rules

– Use this tab to add, edit, or delete rules in a contract.

Running the Quality Assurance Check

– You can use the Quality Assurance Check at any time to check a contract.

Submitting for Approval

– After a contract has passed the Quality Assurance it is submitted for approval.

2.16 Entering General Information
Before you can save a contract a minimal amount of general information must be entered. 
Use this procedure to enter contract general information.

 Prerequisites
You must create a contract, see Creating a New Contract Manually.
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Steps
1. Navigate to the Contracts Authoring window.

2. Enter the contract number.

3. If you have entered a contract number that already exists for another number, then select 
a modifier to distinguish this contract.

4. Select a Buy or Sell for intent. 

5. Enter an end date (if not perpetual).

6. In the Details subtab, enter at least one group name.

7. Save your work.

You are now ready to enter the rest of the contract information. Go to Entering Summary 
Information.

Guidelines
At any time you can save an incomplete contract as a template, using Save as Template from 
the Actions menu.

2.17 Entering Summary Information
Use this procedure to enter summary information for a contract.

Prerequisites
None

Steps
1. Navigate to the Contracts Authoring window.

2. In the Effective region of the Summary tab, enter this information:

n Intent (buy or sell)

n Perspective

n Start date

n End date (this is entered only if contract is non-perpetual)

3. In the Details tab, enter the approval workflow information.
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a. Choose QA Checklist from the list of values. Contracts automatically executes the 
default checklist in addition to your own checklist.

b. Optionally, select Auto Renew. You must also provide the number of days before 
the contract is automatically renewed by a concurrent program.

c. Select a contract group. You must assign the contract to at least one group.

4. In the Administration subtab, select your approval workflow. 

5. You can give assign access to groups or individual users in the Access region.

You are now ready to enter the rest of the contract information. Go to Entering Contract 
Parties and their Contacts.

Guidelines
You can enter condition types and actions, quality check a contract or submit it for approval 
using the buttons at the bottom of the window.

At any time, you can check if your contract passes Quality Assurance. The result of the 
on-line Quality Assurance check is displayed as soon as it completes. There is no need to 
run the Quality Assurance before you submit the contract for approval, since the Quality 
Assurance is automatically run before submitting for approval.

2.18 Entering Parties and Contacts
In the Parties tab, you can identify the legal parties for the contract. You can also enter 
individuals involved with the creation and management of the contract as contacts for the 
parties. Sales contacts can also be entered. The information you enter depends on the 
category and intent. 

Prerequisites
None

Steps 
1. Navigate to the Contracts Authoring window.

2. In the Parties tab, select the party’s role.

3. Select the party’s name. You can also add the alias the party uses for the contract and 
the Also Known As identifiers for the party.

4. In the Party Contacts region, enter a contact, sequence, and a name of the contact. The 
sequence determines the order the contacts should appear.
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The affirmative action fields are automatically filled. You are now ready to enter the rest of 
the contract information. Go to Specifying Contract Line Item Information.

Guidelines
You cannot enter new customers from the Authoring window. If you enter a contract and 
you need to add a new customer or a supplier, then you must first define the new customer 
or create a supplier.

2.19 Specifying Line Items
In the Line Items tab, you can detail all the contract line items, which are the contract 
deliverables and relevant items. The Line Items tab has three subtabs: Sublines, Rules, and, 
Parties. You can use the subtabs to add and exclude data specific to a line. Use this 
procedure to enter details for a line.

Prerequisites
If you want to use price lists, then you must enter the price list in the pricing rule in the 
contract Rules tab.

Steps
1. Navigate to the Contracts Authoring window.

2. In the Line Items tab, enter the line style and a number for the display sequence.

3. Depending on the line style definition, you may enter the description or select a 
description from the list of values.

4. Enter a quantity.

5. Enter the unit of measure.

6. If a list price is defined for the item in the price list, then the unit price is retrieved and 
displayed. Otherwise, you can enter the unit price. The extended price is automatically 
calculated from the quantity times the unit price. The calculated value also populates the 
Net Price field.

Note: If the your line item is priced at the top level, you can enter quantity, 
unit of measure and price information. You can override the contract level 
price list by choosing a price list in the Rules subtab.
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7. If you want to adjust the net price enter a value in the Adj% field. Entering a positive 
value results in a decrease in the net price (i.e for a discount). Entering a negative value 
results in an increase in the net price (i.e. for a surcharge). 

8. Optionally, depending on the line type you selected, use the Sublines tab to enter more 
detail in the sublines.

You can enter sublines for those lines defined to contain sublines in the line style 
hierarchy. This window allows you to view and edit the hierarchy at any level. Navigate 
through levels by using the Drill Up and Drill Down buttons.

9. Enter rules on lines the same way rules are entered on the contract.

10. Use the Parties tab to add line specific information that is not valid for the entire 
contract. Entering a party in a subline is similar to entering party information for the 
contract.

You are now ready to enter the rest of the contract information. Go to Entering Article 
Information in a Contract.

References
Entering Rules

Line Styles

2.20 Entering Articles
An article is the text that describes and details the terms and conditions that are attached to a 
contract.You can enter standard and nonstandard articles while authoring a contract. 
Whenever you use a standard article within a contract, all rules that have been associated 
with that article are copied into that contract. For additional information, see Contract 
Articles.

Note: The Action menu has a menu item “Update Negotiated Price”. When 
the menu item displays Update Negotiated Price ON, the negotiated price 
will default to the extended price and any further changes in the extended 
price will reflect in the negotiated price. The user can override the negotiated 
price later. When the menu item shows Update Negotiated Price OFF the 
negotiated price will not change if the extended price changes. See Setting up 
System Profile Options.

This menu item is disabled when integration with Oracle Pricing is used.
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You can perform the following actions:

n Entering a Standard Article

n Entering a Non-Standard Article by copying a Standard Article

n Entering a Non-Standard Article

You can define rule groups during the initial setup of the standard article set. Whenever you 
use a standard article set, the rule groups defined for that set (compatible to your contract 
category) are copied into the contract where they can be modified. Rule groups are not 
copied when individual articles are selected for reference or copy.

Edit existing article sets and create new article sets by navigating to the Application Object 
Library Lookups window and find OKC_ARTICLE_SET. You can edit the Meaning, 
Description, and Effective Dates for an existing Article Set. Create a new Article Set by 
entering the Code, Meaning, Description, and Effective Dates.

2.20.1 Entering a Standard Article
Use this procedure to reference a standard article or article set while authoring a contract.

Prerequisites
None

Steps
1. Navigate to the Contracts Authoring window.

2. In the Articles tab, leave the Standard check box selected. 

3. In the name field, select an article set.

4. Select the article. Optionally, double-click the article set to select only one article. If 
you know your article, then you can type in fragments of the article to reduce the list of 
values matching your search criteria. This second method bypasses the navigation 
through article sets. 

5. Click Reference.

6. Optionally, click Show Text to modify the text.

7. Save your work.
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Guidelines
When selecting an article set, the rule groups defined for that set are copied into the contract. 
When selecting an individual article, rules are not copied.

2.20.2 Entering a Non-Standard Article by Copying a Standard Article
Use this procedure to copy an existing standard article and modify it.

Prerequisites
None

Steps
1. Navigate to the Contracts Authoring window.

2. In the Articles tab, leave the Standard check box selected.

3. In the name field, select an article set.

4. Select the article. Optionally, double-click the article set to select only one article. If 
you know your article, then you can type in fragments of the article to reduce the list of 
values matching your search criteria. This second method bypasses the navigation 
through article sets. 

5. Click Copy. The standard flag is automatically unchecked when you choose to copy an 
article instead of referencing it.

6. Optionally, click Show Text to modify the text.

7. Save your work.

2.20.3 Entering a Non-Standard Article
Use this procedure to create a nonstandard article.

Prerequisites

A contract must be created, even if it is only in its initial authoring stages.

Steps
1. Navigate to the Contracts Authoring window.

2. In the Articles tab, clear the Standard check box.

3. Enter a name to describe your nonstandard article.
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4. Click Show Text and enter the article text.

5. Save your work.

2.21 Entering Rules 
Use this procedure to add, edit, and delete rules at the contract header or line level while 
authoring a contract.

Prerequisites
None

Steps
1. Navigate to the Contracts Authoring window and select Rules tab.

2. Select a Rule Group. Rules associated with a selected Rule Group appear in the Rule 
region (below Rule Group). To distinguish rule groups that have the same name, you 
can enter a comment or description for each rule group. Depending on the rule group, 
you may have to enter an object and/or subject. See Object and Subject. 

3. Select a Rule. If the Required check box (read only) is selected, this indicates the rule is 
required for that Rule Group. If the Entered check box (read only) is selected, this 
indicates Rule Detail Values were entered for that rule. 

4. Enter a Value for the Rule Detail when the Required check box (read only) is selected.

5. Enter values as needed for other Rule Details.

6. Save your work.

References
Understanding Contract Rules

Defining Rule Groups

2.22 Running the Quality Assurance Check
Use this procedure at any time to check if your contract passes Quality Assurance. The 
results are displayed as soon as the check completes. This procedure is not required before 
submitting a contract for approval because a check is automatically made during the 
approval process. You can use this check to verify the completeness of your contract.
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Prerequisites
You must set up Quality Assurance checks first.

Steps
1. Navigate to the Authoring window.

2. Select or author a contract.

3. Select the Check Contract button. A window displays Quality Assurance comments.

Guidelines
There is no need to run the Quality Assurance before you can submit the contract for 
approval.

2.23 Submitting a Contract for Approval
Use this procedure to submit a contract for approval.

Prerequisites
None

Steps
1. Navigate to the Contracts Authoring window.

2. From the Actions menu, choose Submit for Approval, or select the Submit for 
Approval from the Contracts Authoring window. The Quality Assurance check 
executes automatically. The contract is submitted only if it passes Quality Assurance. 

3. If the contract does not pass the Quality Assurance check, then you can choose to 
continue with the submission.

2.24 Using Conditions     
You now can enter conditions in one of two ways: 

n Copy condition templates into your contract.

n Create a new contract-specific condition.

References
For more information on conditions, see Contract Events Description.
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For more information on combining rules and conditions, see Using Conditions and Rules.

2.24.1 Copying a Condition Template
Use this procedure to copy a condition template into your contract.

Prerequisites
None

Steps
1. Navigate to the Contracts Authoring window.

2. Click the Conditions button.

3. Select Copy From Template from the Actions Menu.

4. Use the Condition Template list of values (LOV) to enter the condition template name.

5. Modify or amend the condition for the current contract.

2.24.2 Creating a Contract-Specific Condition
Use this procedure to create a contract-specific condition for your contract. 

Prerequisites
None

Steps
1. From the Navigator, choose Contract Events > Define Independent Condition. The 

Independent Condition window appears.

2. Enter a name and a description.

3. Select the Create a Task check box if you want to create a task for the Schedule tab in 
the contract overview. You have access to the tasks through the CRM Task Manager as 
well. Creating a task requires entering a task owner.

4. Select the condition type. For Action you must select an action from the Action Based 
Conditions LOV. For Date you must enter the number of days, qualify before or after, 
and the triggering date.

5. For condition of type action choose if the event is evaluated only once or each time the 
condition is met. For example: Select the Evaluate Once Only check box if you want to 
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evaluate the condition to true only if the counter exceeds 1,000 for the first time. Do not 
select the check box, if you want the condition to evaluate to true each time the counter 
reaches 1,000.

6. Enter information to create condition lines.

7. Display the condition lines and check validity.

Select the Show Condition button to display all condition lines and check their 
syntactical validity on-line. The Valid field is display only and gives you a quick 
overview if the condition has validated successfully.

8. Select Outcomes previously defined in the Process Definitions Window.

9. Select the Parameter button to assign fixed values or action attribute values to the 
outcome parameters.

10. Save your work.

References
Defining Condition Templates

2.25 Maintaining Contract Groups 
Once you create a contract group you need to maintain its membership. You can manage and 
oversee the groups that were created by the group definition. For more information 
explaining the function for contract groups see Contract Groups. 

2.25.1 Assigning Contracts 
Use the Contract Groupings window to maintain group hierarchies or to assign contracts to 
groups. In each of the tabs, Contracts and Groups, you can choose between two views. One 
view gives you access to all unassigned contracts or groups. The other expands the 
candidates to all groups or contracts.

Use the left arrow in the middle to select a group or contract from the right and add them to 
the group on the left. To remove a contract or group, select that contract or group on the left 
side and press the right arrow.

Steps
1. From the Corporate Contracts Manager Navigator, choose Contract Groups > Assign 

Contract Groups.

2. Select a contract group from the Contract Navigation tree.
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3. Click Find. The Search Templates window appears. 

4. Enter your search criteria.

5. Click Search.

6. Navigate to the Contract Groupings window. The contract number should appear 
under the Available Contracts region.

7. Select the contract number and click the left arrow.

8. Save your changes and close the Contract Groupings window. The contract should be 
assigned to a new contract group.

2.26 Using the Events Controller
The Events Controller form can be used by contract administrators as a diagnostic tool for 
events, outcomes, workflow background processes, and advance queues. This form provides 
a more convenient method of viewing more information from one location. 

This form contains three tabs:

n Background Process

n Queue Content

n Queue Status

To locate this form (N) Navigator > Contract Events > Events Controller.

2.26.1 Background Process
This tab displays the events and outcome listeners that are running in the background and 
the workflow engine process. In the event of an error, this tab provides you with the ability 
to access an Errors window which describes the error and the cause. 

The following attributes are displayed in this tab:

Note: The Asynchronous Errors form only displays queue errors. For 
more information see, the next procedure Reviewing Errors from 
Asynchronous Processes. 

Attribute Description

Request Id This is the Id of the concurrent program submitted.
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2.26.2 Queue Content
This tab displays the Queue Messages and Queue Errors that have occurred. If an event is 
launched (such as contract signed) you can expect to see the queue content within this tab. If 
there is nothing in the queue, then the Queue Status tab is used to check the queue status and 
also to check if all queue objects are valid.

The following attributes are displayed in this tab:

2.26.3 Queue Status
This tab displays the queue name, queue objects, and their status (valid or invalid). 

The following attributes are displayed in this tab:

Listener/Program Identifies the name of the event, outcome, or workflow background 
process.

Phase The Phase displays Pending, Running, or Completed

Status The Status displays Normal or Error. When a program has been 
completed with an “Error” status, you can click Diagnostics to view 
the error details returned by the concurrent program.

Request Date Identifies the date when the program was submitted.

Requestor Identifies the user who submitted the program.

Attribute Description

Queue Name Identifies the name of the advanced queue.

Correlation Identifies the correlation Id such as KSIGN, KEXTEND, and so on.

Consumer Consumer is the program which parses and consumes the message in 
the queue. 

Enqueue Time Shows date when the message was placed in queue.

Queue Content Displays queue content.

Source Name Shows source of error. 

Retrys Displays number of times the queue tried to dequeue the message.

Begin Date Shows Date when error occurred.

Error Details (Button) Enables you to view the details of queue errors.

Attribute Description
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2.27 Reviewing Errors from Asynchronous Processes
The Asynchronous Errors window displays all error messages of advanced queueing 
processes that have failed. This window displays Queue Name, Message ID, and the 
Message Text.

Usually this window is used by your support representative to resolve issues. From the 
Navigator choose, Contract Events > Query Asynchronous Error Messages.

Attribute Description

Queue Table Shows the queue table name.

Queue Type Displays the queue type such as normal, exception, and so on.

Enqueue Enabled Shows either Yes/No

Dequeue Enabled Shows either Yes/No

Start Queue/Stop Queue 
(Buttons)

Enables you to start or stop the queue.

Queue Objects Names all the okc advance queue objects.

Object Type Displays type of object such as, Table, View, and so on.

Status Type Shows whether object is valid or invalid.

Last Modified Displays date when the object was last modified.

Details (Button) Shows details for rules and subscriber objects.
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2.28 Using Opportunity Integration
Opportunity Integration enables forecast of Contracts revenue directly into Oracle Telesales. 
This creates revenue opportunities in Oracle Telesales from new contracts or contracts to be 
renewed. Opportunity Integration helps in generating an accurate sales revenue forecast. 
Earlier, the revenue from contracts had to be manually entered that usually lead to an 
inaccurate figure. Opportunity Integration now helps sales representatives track contract 
renewals and prevent loss of revenue.

Business Rules for Opportunity Creation 
An Opportunity can be created from the Contract only if a category allows it. This is 
controlled by a checkbox on the Define Category form. The other conditions that apply on 
Opportunity creation are:

n The Contract has an Intent of "Sell". Buy Contracts do not result in an Opportunity.

n The Contract has a Customer.

n The Contract has a salesperson assigned to it from the JTF Sales Group. The name of 
this sales rep. should be specified in Contacts region of the Parties tab. This is possible 
only if Vendor is selected in the Roles drop down list.

n Opportunity is created only when the category of a Contract is enabled for this purpose. 
By default, the seeded categories for Contracts Core and Contracts for Service is 
enabled for Opportunity creation.

n Opportunity is created only the lines belonging to an inventory item are involved in 
Opportunity creation. When a line and its sub-lines are sourced from inventory, only the 
top line is sent to create an opportunity. The sub lines information is available in Oracle 
Contracts, Oracle Telesales, and Oracle Order Capture.

Manual and Automatic Opportunity Creation
Opportunity can be created manually and automatically. It can be initiated manually from 
the Contracts Authoring form and automatically for contract renewals and expiring 
contracts.

2.28.1 Manual Opportunity Creation 
An entered contract is eligible for Opportunity creation. Opportunities can be created 
through Contracts Authoring > Action > Create Opportunity. This menu option is 
enabled only for contracts in Entered status. Opportunity creation requires a set of 
parameters. These are:

n Win Probability
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n Expected Number of Days to Close

Win Probability can be picked from the list of values (LOV). The initial default values for 
both parameters are set in Telesales. The information entered in the authoring form allows 
you to override the win probability defined by the profile. The expected number of days for 
closing of an Opportunity are calculated as the number of days between the current date and 
the contract start date. If the expected closed date is not available, then the Contract start 
date is used. If the expected number of days is changed, then the opportunity is created on a 
corresponding date.

Steps
1. From the Contracts Authoring window navigate to Action > Create Opportunity. Create 

Opportunity window will be appear.

2. Select the Win Probability 

3. Select Expected Number of Days to Close. 

4. Click OK. An Opportunity will be created.

2.28.2 Automatic Opportunity Creation
An opportunity can be created automatically if a contract is set to auto renewal at or before 
expiration. In this scenario, the system will create a opportunity for the expiring contract. 
When a concurrent process "Contract Auto Renewal" is run, a new contract will be 
automatically created subsequently creating a new opportunity.

2.28.2.1 Opportunity Creation During Renewal
An Opportunity is created automatically at renewal if the Contract category is eligible for 
Opportunity creation. Some values are derived from corresponding Oracle Telesales profile 
values. Contracts will use the default values for Win Probability, and Expected Number of 
Days to Close from the Oracle Telesales profile values.  

Steps 
1. Navigate to Contracts Authoring > (T) Summary.

2. Enter Contract Start Date and End Date.

3. Click Details sub tab. Ensure that the Auto Renewal checkbox is selected and the field 
Number of Days Before Expiration is entered. 

4. Click Rules. 
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5. Click Rule Group and select Revenue from the LOV. Subsequently, Rule field displays 
Revenue Estimation. Rule Detail displays Estimation Percent and Date Estimate.

6. Enter Estimation Percent. This is a Win Probability.

7. Enter Date Estimate.

8. Click Parties.

9. Select Vendor in Role LOV. Enter in the name of a valid sales representative assigned in 
the Contracts region.

An Auto Renewal concurrent program is run and creates Opportunity when a contract is 
renewed. 

Opportunity creation for Contracts about to expire
When a contract is about to expire and is not renewed, an opportunity can be created 
automatically. This is done using the Events engine. Oracle Contracts Core has a "create 
opportunity" outcome. The Date Based Assembler, a part of the Events Engine will search 
for the contracts that meet this condition and will create opportunities for contracts those are 
about to expire. 

2.28.3 Opportunities handled by Oracle Telesales
Once an Opportunity is created, it is handled by Oracle Telesales and is manually updated by 
the salesperson and not through any concurrent program. Every Opportunity has one or more 
Sales Representatives assigned to it who can update data in an Opportunity. The other 
features of Oracle Telesales are:

n A manually created Opportunity is created with a status. The status is defaulted based 
on profile options set at the application, responsibility and user levels.  Only some 
statuses are not used for forecasting. 

n An Opportunity can be created in any currency. 

n A quote can be created from an Opportunity. An opportunity and the contract does not 
remain in sync. An update to one does not automatically update the other.

n Products in Inventory will belong to a product category.  If an Opportunity is not being 
created for a product, the product category must be specified.

n After an opportunity is created it can be viewed by the sales representative.

Steps
1. Switch responsibility to Telesales Agent. For this, you need to log in as a Telesales 

agent.
2-40 Oracle Contracts Core Concepts and Procedures



Using Opportunity Integration
2. Navigate to eBusiness Centre.

3. Choose role and group from the LOV in a pop up window.

4. Select Party Type and choose Organization from the LOV

5. Select Organization  and choose appropriate value from the LOV.

6. Click Opportunity sub tab. All opportunities are displayed on left. By clicking on a 
specific opportunity, the details are displayed on the right side. An opportunity name 
constitutes of the contract number and the modifier. The defaulted fields on that form 
are Win Probability, Channel, Status, Sales Stage, Close Date and Campaign Code (if 
required).
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2.29 Using Pricing Upgrade Concurrent Program
Oracle Contracts release 11.5.6 has a tight integration with Oracle Pricing product. For the 
purpose of integration there were data model changes in the contract lines and headers table. 
The purpose of the Oracle Pricing Data Migration Concurrent Program is to migrate 
contracts related data of customers prior to 11.5.6 to the new data model changes introduced 
in 11.5.6 and to enable the Advanced Pricing Profile. 

The concurrent program updates the line_list_price and the price_list_id on contract lines 
and header tables for contracts of classes belonging to Contracts Core. Pricing upgrade is a 
one time job which is to be done when customers upgrade to 11.5.6 from prior versions. 

The following table shows the new columns added to the Contracts Core tables for Oracle 
Pricing integration:

Line Level Overview:
n For non-priced lines, the price_list_id will be NULL.

n For Priced lines, price_list_id will be obtained from the Pricing Rule attached to the line 
or any line level above it or from the header level (if there is a Pricing Rule attached at 
the header). If price_ list_ id cannot be found a default price list id which is the 
parameter for the concurrent program is used.

Header Level Overview
n Price_list_id will be obtained from the Pricing Rule attached to the header. 

n If no Pricing Rule is attached to the header, price_list_id at header level will be NULL.

2.29.1 Data Maintained for Upgrade
For the table “okc_qp_upgrade”, the following data is maintained:

OKC Table New Columns

OKC_K_HEADERS_B price_list_id

Total_line_list_price

OKC_K_LINES_B price_list_id

Line_list_price

OKC_LINE_STYLES_B item_to_price_yn

price_basis_yn
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Sample Data
The following table shows sample data:

Data Meaning

Line_type This specifies the line type of Summary, Category, and Contract. 

Creation_date The date when the record in okc_qp_upgrade was created. In the case 
of line_type = ‘SUMMARY’, this is the upgrade start date. 

In the case of line_type = ‘CATEGORY’ this is the category upgrade 
start date. 

For line_type = ‘CONTRACT’ this is the date when the contract was 
upgraded.

Last_update_date The date when the records in okc_qp_upgrade was last updated. In the 
case of line_type = ‘SUMMARY’ if completion_flag is Y, this is the 
upgrade end date. 

In the case of line_type = ‘CATEGORY’ if the completion_flag is Y, 
this is the category upgrade end date. 

For line_type = ‘CONTRACT’ this will be same as the creation_date.

Completion_flag Y = Upgrade Completed

P = Upgrade in Progress 

N = Upgrade not Completed 

In the case of line_type = ‘SUMMARY’ it will have the following 
values: Y or N

In the case of line_type = ‘CATEGORY’ it can have the following 
values: Y or N or P

In the case of line_type = ‘CONTRACT’ this will have the value: Y 

Scs_code This is the category name which is upgraded. This has a value only for 
line_type= ‘CATEGORY’ 

Chr_id This is the contract id of the contract that is upgraded. This has a value 
only for line_type= ‘CONTRACT’

Request_id This is the concurrent_request_id of the program you submitted, This 
has a value only for line_type= ‘CATEGORY’ or ‘CONTRACT’

Dflt_price_list_id This is populated when the default price list (which is a parameter) for 
one or more priced lines on a contract is stored. For contract lines 
which have pricing rules attached the price list id from the pricing rule 
is used.This has a value only for line_type= ‘CONTRACT’ 
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2.29.2 Concurrent Program Parameters
The following describes the parameters of this concurrent program:

n Default Price List: If the priced lines don’t have any pricing rules attached to them or 
any level above them and if there is no pricing rule attached at the contract header. The 
price_list_id for the priced lines will be defaulted to the user entered parameter p_dflt_
price_list_id. The Default Price List is a Required Parameter.

n Category: You can specify the category of the contracts to upgrade. If you do not 
specify the category, the concurrent program will fetch all categories of classes 
belonging to Contracts Core or Contracts for Sales and run the upgrade. At any given 
point of time, only one concurrent program can be in progress for a category. 

n Enable Advanced Pricing Profile: After all the contracts have been upgraded and you 
have ran the exceptions scripts and verified the report, you can use this option to enable 
the OKC Advanced Pricing Profile option. If you select this option, it will check if all 
the categories have been successfully upgraded. If yes, it will update the SUMMARY 
record in okc_qp_upgrade to complete and enable the OKC_ADVANCED_PRICING 
profile to Y. This option can only be used only after all the contracts have been 
successfully upgraded 

n Upgrade Status Report: This report shows all the categories that have been upgraded 
and identifies any categories that are not yet upgraded.

Column Name            

Line_type Summary Category Contract

Creation_date 01-SEP-2001 01-SEP-2001 01-SEP-2001

Last_update_date 09-SEP-2001 09-SEP-2001   

Completion_flag Y Y Y

Scs_code   NETWORK NETWORK

Chr_id        1234567890

Dflt_price_list_id     898989

Request_id   123456 123456
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2.29.3 Using Pricing Upgrade

Prerequisites
Before running the upgrade program, a modifier must created. This enables modifier details 
to create manual adjustments for all priced lines if there is any difference between line_list_
price and price_negotiated. 

Use the Define Modifier form ((N) Setup > Others > System > Pricing > Modifier Setup) 
for creating the modifier. The information you need to create the modifier is as follows:

Modifier name: OKC_QP_UPGRADE. 

Modifier Summary Tab:

n The modifier must have 2 line types: Discount and Surcharge. Discount would be used 
if line_list_price is more than price_negotiated. Surcharge would be used if line_list_
price is less than price_negotiated.

n Both the modifier lines must be of type ‘Override’ and have Pricing Phase as ‘List Line 
Adjustment’.

Discount / Charges Tab:

n Application Method for both lines must be ‘Amount’.

For step by step instructions for creating the modifier see, Oracle Pricing User’s Guide. 

Steps

1. From the Contracts Manager Navigator, (N) Control > Requests > Run.

2. Select Upgrade Contracts to Use Advanced Pricing for name. The Parameters form 
appears.

3. Select default price list.

4. Select the contract category. If you leave blank all categories are selected for Contracts 
Core and Contracts for Sales. 

5. Select Yes for Enable Advanced Pricing (optional).

6. Select Yes for Report Upgrade Status (optional).

Warning: When the Pricing Upgrade is in progress, no one should be 
using the contracts application.
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7. Click OK.

8. Click Submit and note ID Request Number.

9. N) Control > Requests > View. Check the phase and status of your request.

10. If you selected Yes for Report Upgrade Status then click View Output to view the 
report.
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2.30 Using Oracle Pricing
Oracle Pricing integration covers the following topics:

n Integration Features

n Prerequisites

n Business Rules

n Assigning a Pricelist

2.30.1 Integration Features
This integration greatly enhances Contracts pricing capabilities. In previous releases the 
pricing functionality enabled users to assign a price list at the contract header level using a 
pricing rule, but discounts, promotions, or other types of discounts that the organization 
might be offering was not used by Contracts. The user would have check whether such 
discounts are being offered, and come back into Contracts and manually update the price of 
the lines to apply the discounts. Integration between Oracle Pricing and Contracts automates 
this procedure.

Oracle Contracts can price contracts using the various discounts, promotions, and so on that 
may be offered for the items specified in the contract lines. Also, header level discounts 
available for orders should be made available through contracts as well.

Pricing Contract Lines
The price of all the items specified in contract lines for which prices have been specified in 
Oracle Pricing, can be obtained with this integration. This way, there is one source price list 
when using Order Management, Order Capture or Oracle Contracts. You can specify the 
price lists for the items in a company’s business and use them from all three applications. 
The prices for all the priced lines in contract can be calculated after application of all the 
discounts, promotions, and surcharges defined in the system for the defined item on the unit 
price specified in the price list. 

To achieve this, you are allowed to choose a price list at the line level. If nothing is 
specified, the price list, if any at the header level will be used, or Oracle Pricing will return 
the best price available if no price list is specified at any level. The discounts and surcharges 
will be qualified based on other information entered in the hierarchy of lines for the priced 
item line. The qualifying adjustments (discounts, surcharges, promotions, and so on) can be 
setup in Oracle Pricing as either automatic or manual. Adjustments can will be automatically 
applied to the unit price.
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Pricing Complete Contract
After a contract has been authored, you can get header level adjustments. The discounts and 
surcharges will be qualified based on information specified at header level in the contract. 
The qualifying adjustments (discounts, surcharges, promotions, and so on) can be setup in 
Oracle Pricing as either automatic or manual. Adjustments can be automatically applied to 
the unit price. Thus the final price shown at the header level will be a roll up of the prices at 
the line level, adjusted with header level adjustments

Viewing Pricing Information in Contracts
You can view price lists applied at various levels and also the adjustments that were used to 
reach at the final price at various levels. To accomplish this, a Pricing tab is part of the 
contracts authoring form. You can assign as well as view information related to pricing of 
the Contract at various levels.

Repricing Contract Lines and Headers
You can reprice a line or the whole contract if some qualifying attributes change and when 
the changing attributes might affect the end price of the line or the header. This enables you 
to make use of all the new discounts and promotions that may have been added between the 
last pricing to this re-pricing. Also, if a priced line gets deleted from the contract, Pricing 
can recalculate its affect on Header level adjustments.

Repricing for a priced line will automatically occur if any line in the same hierarchy, above 
the priced line is updated. The roll up price at the header will reflect this change in price of 
line.

Manual Adjustments
After pricing an item, based on unit price and adjustments defined in the system, you can 
manually update the final price of the item. You can still maintain control on what the final 
price should be for an item.  This can be done by creating a manual adjustment to update the 
price.

Pricing During Copy and Renew
When you copy a contract, the pricing related information will also get copied to the new 
contract. For renew, the contract is repriced.

2.30.2 Prerequisites

Oracle Pricing
The following should be defined in Oracle Pricing:
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n New Qualifier contexts and attributes if different then seeded ones.

n New pricing contexts and attributes if different then seeded ones.

n Request Types if different then seeded ones.

n Source Systems if different then seeded ones. 

n Grouping Source systems in Request Types if different than seeded ones.

n Attribute mapping between line styles, rules, party roles if different then seeded ones.

n Price lists and modifier lists if different than seeded ones are needed.

For more detailed information on setups and using Oracle Pricing see, Oracle Pricing User’s 
Guide.

Contracts Core Profile Options
The following OKC profile options should be setup:

n Allow Manual Price Adjustment (Yes: Allows manual price adjustment)

n Enable Advanced Pricing If this profile option is not enabled, then you will not see the 
Pricing tab in the Contracts Authoring window.

Contracts Core Line Styles
In the line style structure to be able to create price request lines out of a line hierarchy, a line 
should be marked as one or more of the following:

n Priced

n Item to Price

n Price Basis

 For more information see, Defining Line Styles. 

2.30.3 Business Rules for Pricing

Line Styles
n The same line style cannot be both an Priced Item, and basis for another item’s price.

n The same line style can be a Priced Item and ‘Priced’.

n In a hierarchy of lines only one line can be Priced Item. 
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n For a line style hierarchy to be priced, there should be a line style flagged priced and 
one line style flagged priced item.

n Priced line style should be below or same level as PI or BPI in the hierarchy of line 
styles.

n In case of recursive line style, the first occurrence of P,PI or BPI will hold this special 
meaning, in all further occurrences, the value of these flags will always be treated equal 
to ‘N’. 

Contracts Authoring Form
n Price lists and modifier selection in a contract will be limited to the currency specified 

in the contract.

n You will be able to assign only 1 price list to a Contract Header.

n If a price list is present only at the header level. Then Oracle Pricing will use it for 
pricing all the lines in the contract. If the header price list can’t be used to price a 
contract line in question, based on profile option ‘Allow Automatic Price List 
Assignment’ setup, Pricing will use lowest precedence price list that qualifies for line or 
show a WARNING message, stating that the contract line couldn’t be priced

n You will be able to manually update only those price adjustments and calculations 
which have been derived from veritable modifiers and overridable price lists. 

2.30.4 Assigning a Pricelist

Prerequisite
n Create and Define a contract.

Steps
1. If a rule is tied to a modifier (during modifier setup), from the Contracts Authoring 

form, click the Rules tab.

2. Select Rule Group (e.g. Billing)

3. Enter Rule Details information.

4. Click Pricing tab. This shows the whole contract in tree form on LHS. 

5. Perform one of the following:

n If you want the header priced, select the header node on RHS. This will bring up 
the corresponding pricing detail already defined for this contract header on RHS. 
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n If you want the line priced, select the line node on RHS. This will bring up the 
corresponding pricing detail already defined for this contract line on RHS.

6. Choose a pricelist from the LOV and click OK. An LOV of active pricelists will show 
up. This will unassign any adjustments that the user might have previously applied to 
the header and clean up the modifier details. 

7. If you need to adjust the price, Click the LOV in the Adjustment field. The Manual 
Adjustments window opens.

8. Select an adjustment and click OK.

9. Select a Reason from the LOV and click OK (optional).

10. Enter text as necessary (optional).

11.  Click Calculate. The final list will be saved the calculation details will be shown. Also 
when you navigate from this tab, the chosen price list will be applied automatically. 
Calculate should also be used when you have made changes to the quantity of a line 
item or deleted line items. 
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3

Implementing Contracts Core

3.1 Implementing Contracts
This topic group provides general descriptions of the setup and configuration tasks required 
to implement Contracts successfully. 

Following Setup Checklist
After the modules to be integrated are setup, you can start using contracts with few 
exceptions, that are listed in steps 2, 3 and 4. You can incrementally complete your setup, 
while starting to use contracts. We suggest that you follow the order presented here. 
However, for many of the steps, as suggested above, you can change and amend the setup 
while working with the product.

Setup Checklist

Step Required Step Title

1. Optional Integrated Components

2. Yes Security for Category

3. Yes Inventory Item Type

4. Yes Schedule Concurrent Programs

5. Optional Article Set Codes

6. Optional Subject Codes

7. Optional Standard Articles

8. Optional Line Type Codes

9. Optional Line Styles
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3.2 Setup Steps

Step 1: Integrated components
The following list shows all modules and forms that Oracle contracts uses for integration:

System Administration: Define Users
System Administration: Define Responsibilities
Oracle Receivables: Define Customer
Oracle Receivables: Define Accounting and Invoice Rules
Oracle Receivables: Define Payment Terms
Oracle Payables: Define Suppliers
Oracle Payables: Define Payment Terms

10. Optional New Rule Groups

11. Optional Modify Rule Groups

12. Optional Party Roles

13. Optional Party Contacts

14. Optional Sources

15. Optional Category Definition

16. Optional Status and Operations

17. Optional System Profile Options

18. Optional Contract Groups

19. Yes Map Time Unit of Measure

20. Optional Autonumbering

21. Optional Contingent Event Codes

22. Optional Termination Reason Codes

23. Optional Processes

24. Optional Quality Assurance Checklist

25. Optional Actions

26. Optional Independent Conditions

27. Optional Condition Templates

Step Required Step Title
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Oracle Purchasing: Define Buyers
Oracle General Ledger: Define Currencies
Oracle General Ledger: Define Daily Rates
Oracle General Ledger: Define Conversion Types
Human Resources: Define Organizations
Human Resources: Assign Organization Profile Options
Human Resources: Define Locations
Human Resources: Define Persons
Inventory: Define UOM Classes
Inventory: Define UOM
Inventory: Define Item Category
Inventory: Define Master Item
Inventory: Define Item Type Codes
Inventory: Define Category Set
Inventory: Define Organization Items
Pricing: Define Price Lists
Pricing: Define Discounts
Pricing: Define Adjustments
Resource Manager: Define Role Types
Resource Manager: Define Resource Role
Resource Manager: Import Resources
Resource Manager: Define Resources
Interaction History: Setup Action Items and Outcomes for Contracts Communications 
tab

Step 2: Security for Category
Oracle contracts is delivered with default categories you can use. However, you have to 
make sure that the responsibility you are using is given access to the category. By default, no 
responsibility has access to any category, unless explicitly assigned. Before you can access a 
contract of a specific category, you have to include the responsibility of your user in the 
category setup. See, Defining a Category.

Step 3: Inventory Item Type
To source line styles, you can use existing views, that are defined on specific inventory 
system item types. To use some of these integration views, you must define these time types 
first. See Defining Inventory System Types

Step 4: Schedule Concurrent Programs
Schedule concurrent programs to control the automated status change, the scheduling and 
dequeueing of events components. See Scheduling Concurrent Programs
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Step 5: Article Set Codes
Define article sets group articles. See Setting Up Lookup Codes

Step 6: Subject Codes
Define Subject codes to classify articles. See Setting Up Lookup Codes

Step 7: Standard Articles
Before defining articles, you may want to define Articles Sets and Subject codes. To define 
articles. See Defining the Library of Articles

Step 8: Line Type Codes
The line type code defines the top line in the line style definition. See Setting Up Lookup 
Codes

Step 9: Define Line Styles
After you have defined the line type code, you can define the line style. See Defining Line 
Styles

Step 10: New Rule Groups
To create new rule groups. See Setting Up Lookup Codes

Step 11: Modify Rule Groups
There are seeded rule groups you may want to edit or you may want to create new rule 
groups. See Defining Rule Groups

Step 12: Party Roles
In addition to the seeded role like customer or vendor, you can add more roles such as OEM. 
See Setting Up Lookup Codes 

Step 13: Party Contacts
In addition to the seeded contacts, you can add more contact roles such as an arbiter or a 
legal assistant. See Setting Up Lookup Codes

Step 14: Sources
The sources form allows you assign different sources for party roles and contact roles. You 
can modify existing source assignment or add sources to the roles you have defined in the 
previous two steps. See Defining Sources
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Step 15: Category Definition
You can define and modify categories at any time. However, you should carefully plan your 
party definitions, rule groups, line styles and article definitions before defining categories. 
See Defining a Category

Step 16: Status and Operations
Define new statuses for a status type and define allowed operation for each combination of 
status type and category status. See Setting up Status and Operations

Step 17: System Profile Options
For a list of all system profile options see, Setting up System Profile Options.

Step 18: Contract Groups
Make sure you set the system profile option: OKC: Public group creator if you want create 
public groups. See Contract Groups

Step 19: Map Time Units of Measure
You must map your own time units defined to the contracts internal time units seeded. See 
Mapping Time Units of Measure

Step 20: Autonumbering
Automatic contract numbering can help classify a contract based on its attributes such as 
Business Group, Operating Unit, Class, and Category. See Setting Up Autonumbering.

Step 21: Contingent Event Codes
Contingent events may be used to schedule notifications. See Setting Up Lookup Codes

Step 22: Termination Reason Codes
Enter Termination reason codes. See Setting Up Lookup Codes

Step 23: Processes
If you want to add packages, procedures, or functions to be used in conditions or Quality 
Assurance checklists, you have to register them in the process definition screen. If you want 
to add new workflows use this procedure. See Defining a Process 
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Step 24: Quality Assurance Checklists
You can define your own Quality Assurance list, that will be executed in addition to the 
default Quality Assurance list. See Defining Quality Assurance Checklist

Step 25: Actions
Actions allow you to define relevant changes of a contract to be used for event handling. See 
Setting up Actions

Step 26: Independent Conditions
You can define conditions, that are independent of a contract, thus, conditions that evaluate 
for every contract. See Contract Events Description

Step 27: Condition Templates
You can create templates for faster entry of conditions in contracts. See Defining Condition 
Templates
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3.3 Defining Inventory System Types
Oracle Contracts allows you to use different sources for line styles. The underlying views 
for the linestyle sources have been defined. For example, if you want to add an item to the 
linestyle source “Consulting”, you would have to create an inventory item with the inventory 
type “Consulting”.

Currently the item types for the items that are be used by the views have not been defined. 
You need to define inventory lookup codes to define items specifically for all of the 
following line styles.

From an inventory responsibility within the setup menu, choose Setup > Items > Items 
Type and enter the lookup types listed: 

3.4 Scheduling Concurrent Programs

3.4.1 Listener Programs
There are two concurrent programs that need to run continuously. Make sure that the 
following two processes are restarted if the database or the concurrent managers have been 
restarted:

n Listener for Events Queue

n Listener for Outcome Queue

When you start the programs, you should accept the default parameter values, unless you are 
a system administrator. The parameters p_wait and p_sleep refer to technical concepts. A 
system administrator with experience in advanced queueing can use them to improve the 
system performance. 

Use the concurrent request set “Oracle Contracts Core Listeners Request Set” to start both 
programs.

Lookup Type Name

CONSULTING Consulting

SW LIC Software License

K Kit

MEDIA Media Pack

TRAIN Training

EDU Education
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The concurrent program “Date Assembler” should run once every day, preferably later in the 
evening. This program is used for tasks such as automatically renewing contracts that are 
eligible according to the contract definition.

To process Notifications, the request set “Oracle Contracts Tasks” needs to be started. This 
includes four programs:

n Send Task Notifications

n First Escalation of Incomplete Tasks

n Second Escalation of Incomplete Tasks

n Action Assembler for Scheduled Planned Date

3.4.2 Status Change
This concurrent program updates the status of contracts, like: Expiring contracts, realizing a 
future dated termination and activating a signed contract, See Status and Operations. You 
should schedule to run this concurrent program very early in the morning, so that the 
contract status is always synchronized with their effective dates.

3.4.3 Workflow Background Processes
When using Oracle Workflow with other applications, the program “Workflow Background 
Processes” most likely is started to run in recurring intervals. If the “Workflow Background 
Processes” is not scheduled to run, the system administrator must start this process to run 
regularly (i.e. to run every five minutes). 

Prerequisites
None

Steps
1. From the System Administrator responsibility, select Concurrent > Requests.

2. Select Workflow Background Process from the LOV for Name.

3. Select Contract Alert from the LOV for Item.

4. Select Yes from the LOV for Process Deferred.

5. Select Yes from the LOV for Process Time-out.

6. Click OK.

7. Click Schedule.
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8. Select Periodically for Run the Job...

9. Enter 5 (this is determined by the system administrator) and select Minutes from the 
LOV for Rerun every...

10. Click OK.

3.5 Defining the Library of Articles 
The Library of Articles is a small database of previously written and established articles. 
These articles can be referenced and included in a contract. Use this procedure to define a 
new article, edit an existing article, change an article’s release, or view contracts that contain 
a selected article.

For more information on understanding articles see, Contract Articles. For more information 
on using articles see, Entering Article Information in a Contract.

Prerequisites
Lookups must be defined for article sets (OKC_ARTICLE_SET). From the Navigator, 
choose Setup > Contract > Standard Articles > Define Set. 

Lookups must also be defined for article subjects (OKC_SUBJECT). From the Navigator, 
choose Setup > Contract > Standard Articles > Define Subject.

Steps
1. From the Navigator, choose Setup > Contract > Standard Articles > Define Articles.

The Standard Articles Library window displays a tree of existing article sets and the 
articles within each set.

2. Select an article set from the tree.

3. If you want to edit the article set, choose categories and optionally select price types to 
control the value selection when authoring a contract containing articles from the article 
set.

4. If you want to edit or review an existing article, then select the article in the set.

5. If you want to add a new article, then from the Actions Menu, choose New Article, 
enter a name for the article, and select an article subject.

The new article is automatically placed in the selected article set.
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6. If you are either entering the first release for a new article or entering a new release for 
an existing article, then in the Releases tab enter the release name, active date, and 
description.

7. Click Release Text to enter or edit the text.

8. If you want to view contracts that use the release of the existing article, then click Used 
in Contracts. A list of contracts appears.

9. If you want to declare incompatibilities with other articles, then in the Incompatibilities 
tab select the incompatible articles.

10. If you want to add the article to other article sets, then in the Article Sets tab select the 
article sets.

Guidelines
The end date of a release is automatically determined by the start date of the next release.

Creating new releases of articles is a way to maintain different versions of an article. 
Creating a new release does not impact articles in other contracts. To change an article 
already in use, you must create a new release, which automatically becomes the most current 
version after the previous release expires.

Articles can be defined to be incompatible with each other. For example, you could make a 
payment term of 30 days net incompatible with a 10% advance payment. You cannot define 
an incompatibility before both incompatible articles are defined.

The article set in the Standard Articles Library window has two tabs. On one tab you record 
the pricing type. On the other tab you add a category.

If you select a standard article, then the tabs change to Price Types and Categories. In the 
Price Types tab, you can choose price types for your article set. When you author a contract, 
then you can reduce the article sets available by price type. 

When you assign a category to a standard article set, then this article set appears in the list of 
values when you author a contract that is assigned the category. You can then drill down to 
articles from that set. However, the authoring window does not limit the articles you select 
to sets that are assigned to a category. You can still access articles directly when authoring, 
even though their article set is not assigned to the current category.
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3.6 Defining Line Styles
A contract is composed of lines of text. Control the type of information that can be entered 
on a particular line by defining a line style. The line style sets input requirements and sets up 
the lists of values to choose from in a contract line during contract authoring.

The most general and least detailed line in a contract is called the top line. Oracle Contracts 
Core delivers a set of line styles you can use, or you can create new line styles following the 
delivered set as a guideline. You can add line styles in a hierarchy below the top line style to 
control detailed information within the top line. 

3.6.1 Define Line Styles

Prerequisites
Top Line styles must be defined in lookup codes (OKC_LINE_TYPE). From the Navigator 
choose, Setup > Contract > Categories & Sources > Define Line Types.

Steps
1. From the Navigator, choose Setup > Contract > Categories & Sources > Define Line 

Styles.

The Line Styles window displays existing line styles in a tree format.

2. If you want to add a line style below an existing line style in the hierarchy, then select 
the parent line style.

3. Click New in the Menu bar. This is the button with a green plus sign.

A new node will appear in the line style tree with a generated name.

4. Enter a line style name.

5. Choose a line type to classify your line style.

6. If the line style contains a priced item, then select Priced. The tree structure to the left 
will mark priced items by displaying an arrow. See explanation for Pricing Setup for 
Line Styles Overview.

7. Choose one or more sources for the line style information and enter start and end dates.

8. Save your work.

The line style is saved as part of the line style hierarchy.
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Guidelines
There is one special line type: “Free Format”. This line type allows you to enter ad hoc 
definitions that do not rely on existing sources like inventory items.

You can create a price line style at any level in the line style hierarchy. However, you can 
only price one line in the hierarchy chain. 

For all line styles, you can determine the source of the line style. In the authoring window, 
lines with the price flag disabled will not show a list of values if you select system items 
(Inventory) as the source. If a system item line style is not priced, then the item source list of 
values is retrieved in the item sub tab of the line.

If a line style is for a top line for a service contract type, then the Valid Operations tab 
appears. You can see whether or not entitlement and invoicing are allowed for the line styles 
delivered for oracle services.

Entitlement and Invoicing is used for Oracle Contracts for Service only.

3.6.1.1 Pricing Setup for Line Styles Overview
Line Styles defined in Oracle Contracts will play a key role in mapping between Contracts 
data into the format which Oracle pricing understands to qualify and calculate various prices 
and adjustments for an item. 

In Oracle Contracts, lines based on these line style are the ones that hold the items specified 
in a contract as well the special attributes corresponding to these items. These lines will be 
used to construct price request lines to be sent to Oracle Pricing.

A request line in Oracle pricing is a line which holds an item and all its attributes together. 
The item on the request line is priced by the Pricing Engine while using its attributes as 
qualifiers for various pricelists and modifiers. For example, the following line styles 
hierarchy. 

Service

–  Product

–        Deployment

This group of line styles is used to store information about service on various products and 
price of the service could vary based on where the product is deployed and price for service 
is some percentage of the price of the product.

 So the lines corresponding to this line style group would look something like this-

Gold Service

– Movie Camera
3-12 Oracle Contracts Core Concepts and Procedures



Defining Rule Groups
– USA

– INDIA

Then, in this case the price of Movie Camera would need to be determined and then based 
on the price you can calculate the price of Service for the camera. Also, you may want to 
know what would be the service charge if the Camera is deployed in USA.

 Two price request lines are sent to the Pricing Engine. 

n Price of Movie Camera deployed in USA.

n Price of Gold Service for the Movie Camera deployed in USA.

 Using this information, the Pricing engine will return the prices for line I and Line II.

To construct these two request lines, you need to know which linestyle is holding the item 
and at which level to price and if there is any relationship between two items listed. To 
capture, this information the Contract administrator, will select these check boxes for line 
styles:

n Priced_item or Item_to_price (PI): The item that we wish to price.

n Basis_For_Priced_Item (BPI): The item, whose price could affect the price of PI in 
same hierarchy.

n Priced (P): The lowest level at which we would like to price PI or BPI.

In the example line style group. The check box selection is as follows:

 Service (PI)

–  Product (BPI)

–  Deployment (P)

The priced (P) flag indicates the lowest denominator in the list of attributes for a priced item 
(PI), based on which the price of the priced item (PI) can vary. In the authoring form, the 
lines corresponding to priced (P) line styles will be the one holding the price for the priced 
item(PI).

References
Line Styles Overview

3.7 Defining Rule Groups
A rule group is a collection of one or many rules. Rules collect one or many related pieces of 
information. Rule groups control which rules are used in a contract. 
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Your organization can assemble rule groups to enforce business processes and company 
standards. Group rules so that rules with similar characteristics can be easily referenced and 
accessed. For example, create a rule group for billing that would group together rules for bill 
to address, billing schedule, and payment terms. Some rules in the group can be defined as 
optional.

You can use rule groups to make certain rules optional entries for one rule group, while 
leaving it a mandatory rule for another rule group. Assign rule groups to your contracts 
according to your business procedures. You can save incomplete data, but all non optional 
rules have to be complete to pass Quality Assurance. 

Prerequisites
A rule group must be defined as a lookup (OKC_RULE_GROUP_DEF). From the 
Navigator choose, Setup > Contract > Rules > Define Rule Groups.

Steps
1. From the Navigator, choose Setup > Contracts > Rules > Assign Rules to Rule 

Groups.

The Rule Group Definition window appears. 

2. If you want to edit a rule group, then select the rule group.

3. Add or change rule types and indicate whether or not the rule type is optional.

4. Add or change rules for each rule type.

5. Save your work.

Guidelines
When you select a rule group in your contract, all rules of that group are automatically 
copied into your contract. Each rule may be optional or mandatory.

For some rules, sources are provided for each intent (buy or sell). You can modify the rule 
type source. You must not remove an existing source definition. Adding source definitions 
for a new object number does not have an effect.

To access a rule from the authoring window, you must include the rule group in the category 
definition. You can include more than one rule group to a category.

You may have rules where the concept of object and subject is applicable. For more 
information see Object and Subject.
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3.8 Defining Sources
Use this procedure to determine the different lists of values that will appear as sources for 
your roles. For example, in a contract where you are buying services, you the customer 
should show in the list of values for the role of the customer, though you have not defined 
yourself as a customer in your Oracle Receivables customer list. In this case, you define the 
customer for a buy contract to select an organization.

Steps
1. From the Navigator, choose Setup > Contract > Categories & Sources > Define Role 

Sources. The Role Sources window appears.

2. Select a party role.

3. In the Party Sources tab, select a source for the party, select buy or sell, and enter 
effective dates.

4. In the Contact Sources tab, click New from the Menu bar to add a new contact. A new 
row appears.

5. Select a contact, a source for the contact, select buy or sell, and enter effective dates. 
The constrained flag indicates that a relation from the contact to the party is enforced 
through the party ID.

6. Save your work.

Guidelines
You cannot delete a source from a role, once you have defined it. To change your source 
assignment, you expire the current source or contact source assignment and add the new 
source assignment with a start date following the expiration date of the prior assignment.

The sources you can choose from are predefined objects.

3.9 Defining a Category
A category is a type of contract, such as a license agreement or service agreement. Use this 
procedure to define additional categories and components as needed for your business to be 
available for authoring a contract within that category. 

Contract categories are seeded in Oracle Contracts for Service and do not need to be set up. 
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Security for Category
Responsibilities that have been defined need to be assigned access to a category before they 
can read or modify service contracts. See steps 2, 3, and 10 for defining access to a category.

Prerequisites
You must define the Responsibilities in System Administrator.

Steps
1. From the Navigator, choose Setup > Contract > Categories & Sources > Define 

Categories.

2. Enter the category name. The class you select determines what authoring form is used, 
contract or service contract. For example:

n Corporate: Oracle Core Contracts 

n Master Agreement: Oracle Core Contracts 

n License: Oracle Core Contracts 

n Service Agreement: (Seeded value for Contracts for Service)

3. Select the Class from the LOV. The class you select determines what authoring window 
is used, contract or service contract (Service Agreement for service contract). 

4. In the Party Roles tab, select roles that can be included in the contract and enter 
effective dates.

5. In the Rules tab, select rule groups you want to have access to on any of the three levels: 
contract, line, or articles.

6. Select a rule party role and qualify the role as object or subject to restrict the use of the 
role in the rule in a contract.

This is needed because there could be multiple vendors or customers in a contract, but 
you only want to pay or invoice one of them. Enter the role, even if your contract has 
only one vendor or customer.

7. In the Line Styles tab, select top line styles.

Note: For now there are no differences between using Corporate, Master 
Agreement or License. Corporate is the recommended default to use. 
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The tree structure of the entire selected line style is displayed. For every line of a line 
style, the roles entered in the Party Roles tab are shown in the Party Roles subtab and 
the rule groups entered in the Rules tab of the category are shown in the Rules subtab of 
the Line Style tab.

8. If you want a party role to be selectable on the contract line level, then in the Party 
Roles subtab of the Line Style tab, choose Select.

9. If you want a rule group to be selectable on the contract line level, then in the Rules 
subtab of the Line Style tab, choose Select.

10. In the Responsibilities tab, select at least one responsibility and assign access level 
rights to the responsibility along with effective dates.

11. Save your work.

Guidelines
You cannot delete a component from a category. To remove a component from the category, 
you have to expire it. Adding components to a category do not make the components 
mandatory during contract authoring.

Roles for rules is used for service contracts. Following is an example of qualifying a role for 
a rule: Qualify the customer role in the billing rule as the object of the billing role, that is, as 
the party to which the bill is sent. Or, you can determine that your billing rules identify the 
seller as the subject, in other words, the seller would send the invoice. The rule edit would 
then choose the right list of values when you enter rule information.

In the Rule tab, the optional check box determines if the qualified role may be omitted for a 
rule to pass Quality Assurance.

A responsibility not selected on the Responsibilities tab is prohibited access to the contract.

To access a rule from the authoring window, you must include the rule group in the category 
definition. You can include more than one rule group to a category.

References
Understanding Roles and Contact Sources

Understanding Contract Rules

3.10 Setting Up Status and Operations
You can control the operations (such as update on line and delete contract) that can be 
performed on a contract depending upon the category assigned to the contract when it is 
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created and the status of the contract (such as active or terminated). Use this procedure to 
add statuses and to define by category and status which operations can be executed against a 
contract.

For more information on status and operations, see Status and Operations.

Steps
1. From the Navigator, choose Setup > Contract > Status and Operations

2. Select a status type.

3. Optionally, enter additional statuses for the status type, enter the text to display in 
application windows in the Meanings field, and select the default status for the contract 
when it first reaches the stage of the selected status type.

4. For each status, select every category, operation, and level (header or line level) 
combination you want to relate to the status.

5. For each line you created in the Allowed Operations by Category section, select 
Allowed to allow the operation. Clear Allowed to prohibit the operation. 

6. Save your work.

The information you set up is used by the application to control operations for contracts.

Guidelines
If you define a new status for the status type Active, then you have to make sure that you 
specifically allow operations such as on-line update. If you create a new status without 
specifying any allowed operations, then you implicitly allow no operations for this contract 
status.

 In order for the concurrent program Status Change to automatically update contract status 
you must define a default status for each status type.

3.11 Setting up System Profile Options
Use this list to identify profile options you need to change for your implementation. You can 
set these profile options in any order you like. To change profile options, please follow the 
standard procedure outlined in the Oracle Applications Users Guide.

The Personal Profile Values window is used when identifying and defining profile options. 

From the Corporate Contracts Manager responsibility, select Control > Profile Option. 
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3.12 Mapping Time Units of Measure
Oracle Contracts Core defines unit of measure conversion for time differently from Oracle 
Applications. This helps ensure that the scheduling is more accurate than a simple 
conversion such as 1 month = 30 days, which is only correct for 5 out of the 12 months of a 
year.

If you want to define your own time unit conversions for extending a contract or for 
scheduling, then you must define your own time unit conversions. For example, lets say you 
want to define the 4 time units in the Units of Measure menu: Day, Month, Quarter, and 
Year. The UOM Class is Time. The system profile option should be set: OKC: Time UOM 
Class to the value of Time. When you use the Map Time Units window, the list of values 

Option Description 

OKC: Schedule Rule Alert Window The number of days before a due task, that the 
user is notified of upcoming task.

OKC: Change Request Approval This overrides the workflow approver.

OKC: Contract Approver This overrides the workflow approver.

OKC: Schedule Rule Escalate Number of days after a task has missed its due 
date when escalation begins.

OKC: Status Change Batch Size Determines the number of records to be updated 
before they are saved in the database (this 
parameter should be fine-tuned by the database 
administrator).

OKC: Renewed Contract Identifier  This identifier will be attached to the renewed 
contract’s contract number.

OKC: Public Group Creator Privilege to create a public group in Oracle 
Contracts.

OKC: Time UOM Class Limits the units you see in the Map Time Units 
window.

OKC: Update Negotiated Price This drives the default of the Update Negotiated 
Price ON/OFF in the Action menu.

OKC: Default Contract Group This determines the contract group a contract is 
placed, when a contract is created from a quote.

ASO: Automatic Numbering Must be set to "Yes" for integration to Order 
Capture.

OKC: Success Message Recipient This enables a recipient to be notified regarding 
the success of an outcome.
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will only show the time units you assigned to the conversion class Time. When you map 
your own time units to the internal time units:

n Day: 1 Day

n Month: 1 Month

n Quarter: 3 Months

n Year: 1 Year

With this setup, your will only be able to select the values listed above from the LOV when 
defining time components. You will not have access to other time units such as hour or 
minute.

Prerequisites
Define your units of measure classes and units of measure using Oracle Inventory.

Choose the unit of measure class to be used for contracts, and select it for the profile option 
OKC: Time UOM Class. The units of measure within the chosen class appear in the list of 
values for User Unit in the Map Time Units window.

Steps
1. From the Navigator, choose Setup > Contract > Units of Measure > Time Units of 

Measure.

2. Select a user unit of measure from the list of units of measure.

3. Select the base unit of measure that equals the user unit of measure.

4. If needed, enter conversion information.

5. Optionally, enter a description.

6. Save your work.

Guidelines
There are six internal time units: minutes, hours, days, weeks, months, and years. Make sure 
to map each time unit you want to use in Oracle Contracts Core. An example of a mapping: 
Day (your definition) = 1 day (base definition).
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3.13 Autonumbering Contracts
Autonumbering Contracts consists of the following topics:

n Overview

n Autonumber Features

n Autonumber Examples

n Truth Table

n Setting Up Autonumbering

n Setting Up User Function

3.13.1 Overview
Autonumbering functionality will automatically populate the contract number upon 
initiation of a new contract. Utilizing autonumbering functionality, you will have greater 
flexibility in defining how contracts are numbered. 

Contract numbers can be either sequential numbers or a combination of defined prefix and 
suffix alpha-numeric characters to classify a contract based on its attributes. These attributes 
include:

n  Site

n Business Group

n Operating Unit

n Class

n Category 

You can set up auto-number classification using a prefix and suffix with a contract number. 
For example, a ‘Service’ contract originating in the ‘US’ can be numbered US-9999-SRV. 
Use of a prefix and suffix is optional. The numeric part of the contract number will be 
formatted to the length specified for that sequence. For example number 99 will be 
formatted as 00099 if the length is specified as 5 digits.

Autonumbering of contracts will be helpful in a scenario when contracts are entered or 
imported from an external source or system, built from another document, or when contract 
data is entered manually. From the Contracts Launchpad, a contract number can be 
automatically generated when you initiate a new contract by:

n Launching contracts, and selecting New from the Tools drop-down menu.
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n Navigating to the Contract Navigator tab, selecting a contract group from the list, 
highlighting a contract from the right column, and either right clicking the mouse and 
selecting Copy... or selecting Copy... from the Tools drop-down menu. The New 
Contract box in the Copy form must be selected.

n After creating and saving a quote, the user can navigate from the Order Capture form to 
Actions > Create Contract. This initiates a new contract with an automatically 
generated number.

You can manually override the system generated number, assuming the Allow Manual 
checkbox is selected during setup. In addition, if there is no setup defined, manual 
numbering is assumed and the contract number field is not protected from being updated.

3.13.2 Autonumbering Features
The Autonumbering form is used for entering contract numbering setup. In the top section, 
you decide how to number the contracts. There will always be one and only one header level 
record for the entire installation. In case of User Defined Function, there will be no details 
required and the ‘Sequence Details’ region is grayed out. 

3.13.2.1 Site 
A sequence number can be by installation site. One row is active in the Sequence Details 
region. This selection allows entry of Prefix, Suffix, Sequence Number From, Sequence 
Number To, Format Length, and Allow Manual override in the ‘Sequence Details’ region.

3.13.2.2 Business Group, Operating Unit, Class, and Category 
A sequence number can be generated for any of the above attributes. These attributes are 
selected from a LOV. Please refer to the Truth Table for possible combinations of contract 
attributes for generating sequence numbers automatically.

3.13.2.3 User Function 
A user defined function offers the flexibility to build in more logic for generating a sequence 
number. For example, if you can have the contract number reflect the date and sequence 
when the contract becomes active (i.e., 03222001001). Please refer to the Truth Table for 
possible combinations of contract attributes for generating a sequence numbers 
automatically.

3.13.2.4 Enforcing Number Generation
The check box “Allow Manual” indicates whether the contract number is a protected field or 
not. When this checkbox is not selected, the number will be generated automatically and this 
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field is protected. If you select the check box the contract number will only be automatically 
generated when the contract number field is left blank.

3.13.2.5 Prefix/Suffix
Free form fields which help provide ‘classification’ coding to a contract. Note that you can 
use this field to add a separator or delimiter. These values are enter as character only.

3.13.2.6 Sequence Numbers
You may choose to specify a starting and ending number for the numeric part of the contract 
number sequence. If this number is exceeded, you will be prompted to extend the range or to 
enter a unique contract number manually depending on the selection of “Allow Manual” 
check box.

3.13.2.7 Format Length
You can specify a formatting length for the numeric part of the contract number sequence. 
The total contract number length (concatenated suffix, number prefix) cannot exceed 120 
characters.

3.13.2.8 Template
When a contract is created from a template, it generates a number automatically.

3.13.2.9 Copy/Subcontract
When a contract is copied to a new contract, the attributes pertinent to the contract such as 
class and category will NOT change. The attributes such as Business Group and Operating 
Unit will be based on the responsibility using which the copy is being created and NOT 
those of the source contract. A new number will be generated accordingly.
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3.13.3 Auto-Number Examples
The following table shows examples of the “First Number” based upon the various 
combinations selected.

US 

Business 
Group

Operating 
Unit Class Category Prefix Suffix

Sequence 
From

Sequence 
To Length

First 
Number 
Generate

USA   Service   US- -SRV 99 10000 5 US-00099-
SRV

USA   Corporate   US- -COR 55 50000 5 US-00055-
COR

UK  Service  UK- -SRV 1 20000 5 UK-00001-
SRV

UK Corporate  UK- /COR 33 100000 6 UK-00003
3/COR

SP License   /LIC 44  5 00044/LIC

MP  Network MP-NW/  66 60000 5 MP-NW/00
066

OU    77  5 00077
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3.13.4 Truth Table
Depending upon which autonumbering attribute is selected, the Sequence Details fields are 
selectively enabled. For example, if Only Business Group is chosen then Operating Unit, 
Class, Category sequence details will be disabled. The following table (“Truth Table”) 
shows the possible sequences:

Description
User 
Function Site

Business 
Group

Operating 
Unit Class Category

User, no other attributes 
can be selected

Y N N N N N

Site, no other attributes can 
be selected

N Y N N N N

Business Group can be 
selected with Class

N N Y N Y N

Business Group can be 
selected with Category

N N Y N N Y

Business Group can be 
selected without Class or 
Category

N N Y N N N

Operating Unit can be 
selected with Class

N N N Y Y N

Operating Unit can be 
selected with Category

N N N Y N Y

Operating Unit can be 
selected without Class or 
Category

N N N Y N N

Class can be selected 
without Business 
Group/Operating Unit

N N N N Y N

Category selected without 
Business Group/Operating 
Unit

N N N N N Y
Implementing Contracts Core 3-25



Autonumbering Contracts
3.13.5 Setting Up Autonumbering

Prerequisites
The profile option OKC: Document Sequence Name” should be enabled. This profile option 
is used to define a text literal, for example, OKC_DOC to be used for naming Sequences 
created. This profile value is used as a prefix.

The profile option “Sequential Numbering” should be set to “Always Used”. By default, this 
profile is not set up. This profile is set at the application level. This means that, Contracts for 
Service users may use sequential numbering while Contracts Core users can use manual 
numbering.

Steps
1. From the Navigator, choose Setup > Contract > Autonumbering.

2. Select the attribute type (Site, User Function, Business Group, and so on). If you select 
User Function, choose a Process Name from the LOV.

3. Select the Sequence Details (depending upon attribute selected see, the Truth Table for 
attribute combinations) from the LOV in the Sequence Details region.

4. Enter Sequence Numbers From/To (optional).

5. Enter Format Length for the contract number (optional).

6. Enter Prefix/Suffix values (optional).

7. If you want to enter a contract number manually, select Allow Manual. 

8. Save your work.

9. From the Navigator, choose Launch Contracts > (B) Open > Contract Navigator > 
Tools > New.

10. Select a Contract Category from the LOV.

11. Click Create.

12. From the Contract Authoring window verify contract number is correct based upon your 
setup.

13. Repeat steps 9-12 to check contract number sequence. 
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3.13.6 Setting Up User Function

Steps
1. From the Navigator, choose Setup > Contract > Process Definition.

2. Enter Sequence Numbering for the process usage.

3. Enter the following parameters from this table:

4. From the Navigator, choose Setup > Contract > Autonumbering.

5. Select User Function from LOV.

6. If you want manual override, select the Allow Manual check box.

7. Save your work.

8. From the Navigator, choose Launch Contracts > (B) Open > Contract Navigator > 
Tools > New.

9. Select a Contract Category from the LOV.

10. Click Create.

11. From the Contract Authoring window verify contract number is correct based upon your 
setup.

Parameters Description

Site Implementation Site

Business Group Business Group of the responsibility with which the contract is created

Operating Unit Operating Unit of the responsibility with which the contract is created

Class Class of contract

Category Category of contract

Contract Currency Currency code of contract

Contract Amount Estimated amount for contract

Contract Party Information A table of party roles and names to be passed as a record parameter
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3.14 Defining a Process
Use this procedure to name the Oracle Workflow processes or procedures and packages you 
have set up so that they can be understood and used by others to author or modify a contract. 
If you define your own procedures or functions, these will not be supported. When you need 
support, the support representative will request you reproduce the errors without using your 
procedures. 

Prerequisites
You must create the Oracle Workflow processes or procedures and packages first.

Steps
1. From the Navigator, choose Setup > Contract > Process Definition.

2. Enter a unique name and a description.

3. Enter the usage.

4. Select the type of process.

5. Enter information appropriate for the process you are defining.

6. Save your work.

Guidelines
The description appears in the list of values in windows where you need to select a defined 
process.

You can select one of the following usages:

n API (Application Programming Interface)

n Contract approval process

n Change request process

n Function, for condition evaluations

n Outcome, for Events

n Quality Assurance

When entering a workflow or package and procedure names, make sure the spelling is 
accurate. The Process Definitions window does not validate the existence or the valid status 
of the referred objects.
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When defining outcomes for events you cannot use the type script. Script is not referring to 
a SQL script, but is referring to an internal scripting tool used for Oracle Relationship 
Planner.

When adding parameters, make sure that they are entered in the correct order.

3.15 Defining Quality Assurance Checklist
Use this procedure to define a new Quality Assurance (QA) checklist. Contracts validates a 
contract before you can submit it for approval using a QA checklist. Each checklist consists 
of one or more Oracle Workflow processes. 

Prerequisites
You must define the Oracle Workflow processes before adding them to the checklist.

Steps
1. From the Navigator, choose Setup > Contract > Quality Assurance.

2. Enter a name and a description.

3. In the Processes region, select the process that will become a part of the QA checklist.

4. Make sure the Active box is selected.

5. From the Severity list, select one of the following levels:

n Warning: The contract passes Approval.

n Stop: The contract does not pass Quality Assurance if this process fails

6. Optionally, override the default values for the parameters.

7. Save your work.

Guidelines
The default Quality Assurance (QA) checklist is executed automatically for any contract, 
even if you create another checklist for the contract. You cannot modify or update the 
default checklist. 

3.16 Setting up Actions
Use this window to define or modify actions. Examples of actions include contract signed 
and Counter Group XX updated. 
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Prerequisites
None

Steps
1. From the Navigator, choose Contract Events > Define Action.

2. Enter a unique name, select action type, and enter a description.

3. Enter the Correlation. Correlation is a term used in Advanced Queueing to uniquely 
identify the type of message in the queue.

4. If you want to enable the counter tab for this action when defining conditions, then 
select Counter Action.

5. If you want on line action handling, then select Allow Synchronous Outcomes. If you 
want asynchronous, or batch mode action handling, then clear the check box.

6. In the Basic tab, enter attributes. You must enter the name, element name or column, 
and a data type. These attributes can be accessed in the condition definition.

7. In the Advanced tab you can enter the following:

n Min/Max Value: Validates the range of entries in conditions.

n Object Name: Defines the source for the list of values in the Condition Template 
window.

n Column Name: Derived from the object name.

n Date of Interest: Can be used for action based actions only. Select an attribute when 
you want the condition to evaluate to true, for example, the entered signing date. If 
you leave the Date of Interest clear, then the signing date refers to the date when 
the contract signing date was entered, ignoring the value of the date entered.

n Used in Conditions: Clear this check box if the attribute should not be used in 
conditions.

8. Save your work.

Guidelines
The description of the action appears in the Conditions window.

Select Enabled when you are ready to use the condition, or clear Enabled to disable a 
condition.
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3.17 Defining Condition Templates
Use condition templates to define multiple samples of conditions. The templates can then be 
used to define independent conditions or conditions attached to a contract. Use this 
procedure to define a condition template.

Prerequisites
Before an outcome can be assigned to a condition template, it must be defined using Setup > 
Contract > Process Definition.

Steps
1. From the Navigator, choose Contract Events > Define Condition Template.

The Condition Template window appears. 

2. Enter a name and a description.

3. If you want to create a task for the schedule tab in the execution overview:

a. Check the Create a Task check box. 

b. Enter the task owner.

4. Select Action or Date.

5. If you are creating an action condition, then select an action.

6. If you are creating a date condition, then enter the date information.

7. Build your condition lines.

8. If you want to enter fixed values for parameters for a function, then click Parameters 
and enter the information.

9. Click Show Condition to display all condition lines and check their syntactical validity.

 If the condition has validated successfully, then Condition Valid is automatically 
selected.

10. Select Outcomes.

Note: When using the "LIKE" operator, you must not use quotes. For 
example, when building a condition, where contract_number like 
"%-2000%", your right value must be %-2000 and not "%-2000". 
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11. If you want to assign fixed values or action attribute values to the outcome parameters, 
then click Parameters and enter the information.

12. Select Notifications.

13. Select a Success Notifier from the LOV.

14. Select a Failure Notifier from the LOV.

15. Save your work.

Guidelines
You can save your template at any time. You are not required to complete all information in 
the window.

An independent condition does not need to be tied to a contract and can run independent of a 
contract. Therefore, an independent condition has to validate before you can save it.

For condition of type action, choose if the event is evaluated only once or each time the 
condition is met. For example: Select Evaluate Once Only if you want to evaluate the 
condition to true only if the counter exceeds 1,000 for the first time. Clear the check box if 
you want the condition to evaluate to true each time the counter reaches 1,000.

Each condition can consist of one or more condition lines. The sequence determines the 
order in which the lines are processed. You can enter three types of lines.

n Expressions: The left value only allows you to enter attributes defined in the action 
attributes.

n Counter: Select Product or Service and choose a description of the service or product 
(The Counter tab does not show for Contracts Core).

n Functions: Select Functions declared in the Process Definitions Window. To enter 
values for parameters, select the Parameter button.

Note: If you select a counter group, then your left value lists counter group 
types. If you choose a counter group master, then your left value shows the 
related counter groups. 
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3.18 Setting up Approvers
Use this procedure to define the approver for both change requests and contracts if you do 
not have an Oracle Workflow process defined to handle approvals. 

Prerequisites
You do not have an approval process defined using Oracle Workflow.

Steps
1. To set up an approver for change requests, enter the names in the system profile option: 

OKC: Change Request Approver. This profile options overrides a workflow setup and 
uses the approver, if the workflow is not yet defined.

2. To set up contract approvers, enter the names in the system profile option: OKC: 
Contract Approver. This profile options overrides a workflow setup and uses the 
approver, if the workflow is not yet defined.
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3.19 Setting Up Lookup Codes
Use this list to identify lookup codes (QuickCodes) you need to define for your 
implementation. You can set them up in any order. Please follow the standard procedure 
outlined in the Oracle Applications Users Guide.

The Application Object Library Lookups window is used when identifying and defining 
Lookup Codes. 

From the Corporate Contracts Manager responsibility, select Setup > Others > System > 
Lookups.

Code Description

OKC_ARTICLE_SET Defines sets of articles.

OKC_CHANGE_REQUEST_
STATUS

Defines status for change request such as approved, 
rejected, etc.

OKC_CONTACT ROLE Defines contact roles.

OKC_CONTINGENT_EVENTS Defines contingent events for the schedule tab.

OKC_LINE_RENEWAL_TYPES Defines types of renewal for contract lines.

OKC_LINE_TYPE Defines line types.

OKC_PROCESS_USAGE_TYPES Defines process usage types.

OKC_RENEWAL_TYPE Defines types of renewals for contracts.

OKC_ROLE Defines contract party roles.

OKC_RULE_DEF Setup rule definitions.

OKC_RULE_GROUP_DEF Place holder for all rules to be assigned to a 
contract.

OKC_STATUS_TYPE Seeded status types.

OKC_SUBJECT Defines subject classification for articles.

OKC_TERMINATION_REASON Defines reasons for terminating a contract. Users 
must specify a reason for terminating a contract.

OKC_TIME Seeded time units.

OKC_WINDOW_TITLES Window titles used in Dynamic window titling.
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4

Customizing Oracle Contracts Core

4.1 Customizing Contracts Core
This topic group consists of the following:

n Customizing Events

n Customizing Workflows

n Registering a New Source as a JTF Object

4.2 Customizing Events
If you customize events, you are doing so at your own risk. Oracle support will not help you 
create or debug actions, functions or outcomes you have created. If you encounter problems 
with customizations and wish to obtain support, then you must recreate the problem using 
standard Oracle objects.

4.2.1 Coding Action Assemblers
In contracts business process, whenever a defined action occurs, the necessary information 
about the attributes needs to be assembled and placed into the Events queue. You need to 
code an action assembler procedure for new actions.

Following are two examples of how you code an action assembler:

Example 1 - When All the Attribute Information is Readily Available
This example accepts all attribute values as parameters. It builds the message table with the 
attribute name (element_name) and value (element_value). It also creates the record 
containing correlation for the action.
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Then it calls the contracts advanced queuing procedure SEND_MESSAGE to queue the 
message.

This example fits when the action occurs in a form where the form contains all the required 
information.

Pseudo Code

/*=====================================================+        
              Copyright (c) 1999 Oracle Corporation                  
                Redwood Shores, California,USA                       
                 All rights reserved.                                
                                                                     
======================================================*/       
                                                                     
SET VERIFY OFF                                                       
                                                                     
WHENEVER SQLERROR EXIT FAILURE ROLLBACK;                             
                                                                     
CREATE OR REPLACE PACKAGE OKC_MY_ASMBLR_PVT AS                  

g_pkg_name CONSTANT varchar2(100) := ’OKC_MY_ASMBLR_PVT’;       
                                                                     
                                                                     
PROCEDURE acn_assemble( 
  /* mandatory parameters do not change */                                             
  p_api_version       IN NUMBER,                                     
  p_init_msg_list     IN VARCHAR2 DEFAULT OKC_API.G_FALSE,           
  x_return_status     OUT NOCOPY VARCHAR2,                           
  x_msg_count         OUT NOCOPY NUMBER,                             
  x_msg_data          OUT NOCOPY VARCHAR2, 
                          
  /* parameters specific to this action assembler to be added here */                                                                   
  p_attribute1_value    IN DATATYPE,                                 
  p_attribute2_value    IN DATATYPE,                                 
  . . .       
  . . .                            );

END OKC_MY_ASMBLR_PVT;                                          
/                                                                    
                                                                     
COMMIT;                                                              
EXIT;                                                                
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/*=====================================================+          
              Copyright (c) 1999 Oracle Corporation                    
                Redwood Shores, California,USA                         
                 All rights reserved.                                  
                                                                       
=======================================================*/         
                                                                       
SET VERIFY OFF                                                         
                                                                       
WHENEVER SQLERROR EXIT FAILURE ROLLBACK;                               
                                                                       
CREATE OR REPLACE PACKAGE BODY OKC_MY_ASMBLR_PVT AS               

PROCEDURE acn_assemble(                                                
  p_api_version       IN NUMBER,                                       
  p_init_msg_list     IN VARCHAR2 DEFAULT OKC_API.G_FALSE,             
  x_return_status     OUT NOCOPY VARCHAR2,                             
  x_msg_count         OUT NOCOPY NUMBER,                               
  x_msg_data          OUT NOCOPY VARCHAR2,                             
                                                                       
/* parameters specific to this action assembler to be added here */                                                                   
  p_attribute1_value    IN/OUT DATATYPE,                                 
  p_attribute2_value    IN/OUT DATATYPE,                                 
  p_attribute3_value    IN/OUT DATATYPE,                                 
  . . .       
  . . .                                )  IS                       
                                                                       
 l_api_name     CONSTANT VARCHAR2(30) := ’acn_assemble’;               
 l_api_version   CONSTANT NUMBER := 1.0;                               
 i               NUMBER := 1;                                          
 l_corrid_rec    okc_aq_pvt.corrid_rec_typ;                            
 l_msg_tbl       okc_aq_pvt.msg_tab_typ;                               
 l_msg_count     number;                                               
 l_msg_data      varchar2(1000);                                       
 l_return_status varchar2(1);
                                         
 /* ‘MY_ACTION_CORRELATION’ is the correlation of the new action for
 which this assembler is being coded */  
                                                                    
 CURSOR cur_corr_csr IS                                                
 SELECT aae.element_name,
        aae.format_mask format_mask                                               
   FROM okc_actions_b acn,
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        okc_action_attributes_b aae                  
  WHERE acn.id = aae.acn_id                                            
    AND acn.correlation = ‘MY_ACTION_CORRELATION’ ;                               
                                                                       
BEGIN                                                                  
                                                                       
 l_return_status := OKC_API.START_ACTIVITY                             
                    (l_api_name                                        
                    ,p_init_msg_list                                   
                    ,’_PROCESS’                                        
                    ,x_return_status);                                 
                                                                       
  IF l_return_status = OKC_API.G_RET_STS_UNEXP_ERROR THEN              
     RAISE OKC_API.G_EXCEPTION_UNEXPECTED_ERROR;                       
  ELSIF l_return_status = OKC_API.G_RET_STS_ERROR THEN                 
     RAISE OKC_API.G_EXCEPTION_ERROR;                                  
  END IF;                                                              
                                                                       
l_msg_tbl := okc_aq_pvt.msg_tab_typ();                                 
 FOR corr_rec IN cur_corr_csr                                          
 LOOP 
 /*   'ATTRIBUTE1_ELEMENT_NAME’ is the ‘element name’ of the action attribute 
for the newly defined action */
 IF corr_rec.element_name = 'ATTRIBUTE1_ELEMENT_NAME’ THEN                             
  l_msg_tbl.extend;                                                    
  l_msg_tbl(i).element_name     := corr_rec.element_name;              
  l_msg_tbl(i).element_value    := p_attribute1_value;                          
 ELSIF corr_rec.element_name = 'ATTRIBUTE2_ELEMENT_NAME’ THEN                             
   l_msg_tbl.extend;                                                   
  l_msg_tbl(i).element_name    := corr_rec.element_name;               
  l_msg_tbl(i).element_value   := p_attribute2_value; 

/* If the attribute is of date or number datatype and the datatype is specified 
while defining the attribute then do the following */

 ELSIF corr_rec.element_name = ‘ATTRIBUTE3_ELEMENT_NAME’ THEN          
   l_msg_tbl.extend;                                            
   l_msg_tbl(i).element_name :=  corr_rec.element_name;                
   IF corr_rec.format_mask IS NOT NULL THEN                  
     l_msg_tbl(i).element_value := to_char(p_attribute3_value,   
                                       corr_rec.format_mask);
   ELSE                                                     
     l_msg_tbl(i).element_value := p_attribute3_value;             
   END IF;                                                  
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 ELSIF . . .
  . . .
  . . .
 END IF;
                                                                       
  i := i + 1;                                                          
 END LOOP;   

 l_corrid_rec.corrid := ‘MY_ACTION_CORRELATION’ ;

/* This procedure puts the message on the events queue */
  OKC_AQ_PUB.send_message(p_api_version     =>’1.0’
                         ,x_msg_count       => l_msg_count
                         ,x_msg_data        => l_msg_data
                         ,x_return_status   => l_return_status
                         ,p_corrid_rec      => l_corrid_rec
                         ,p_msg_tab         => l_msg_tbl
                         ,p_queue_name      =>
                         okc_aq_pvt.g_event_queue_name);

    IF l_return_status = OKC_API.G_RET_STS_UNEXP_ERROR THEN
        RAISE OKC_API.G_EXCEPTION_UNEXPECTED_ERROR;
    ELSIF l_return_status = OKC_API.G_RET_STS_ERROR THEN
        RAISE OKC_API.G_EXCEPTION_ERROR;
    END IF;

 OKC_API.END_ACTIVITY(x_msg_count, x_msg_data);

EXCEPTION
 WHEN OKC_API.G_EXCEPTION_ERROR THEN
  x_return_status := OKC_API.HANDLE_EXCEPTIONS
                       (l_api_name,
                        G_PKG_NAME,
                      ’OKC_API.G_RET_STS_ERROR’,
                        x_msg_count,
                        x_msg_data,
                        ’_PROCESS’);
 WHEN OKC_API.G_EXCEPTION_UNEXPECTED_ERROR THEN
  x_return_status := OKC_API.HANDLE_EXCEPTIONS
                       (l_api_name,
                        G_PKG_NAME,
                       ’OKC_API.G_RET_STS_UNEXP_ERROR’,
                        x_msg_count,
                        x_msg_data,
                        ’_PROCESS’);
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 WHEN OTHERS THEN
  x_return_status := OKC_API.HANDLE_EXCEPTIONS
                       (l_api_name,
                        G_PKG_NAME,
                        ’OTHERS’,
                        x_msg_count,
                        x_msg_data,
                        ’_PROCESS’);
END acn_assemble;

END OKC_MY_ACTION_ASMBLR_PVT;  
/

COMMIT;
EXIT; 

Example 2 - When Attribute Information Needs to Be Assembled
This example accepts key information about the action, for example contract_id, and collects 
the values for all the attributes from the database. It builds the message table with the 
attribute element name (element_name) and value (element_value). It also creates the record 
containing correlation for the action.

Then it calls the contracts advanced queuing procedure SEND_MESSAGE to queue the 
message.

This example fits where the action occurs in the middle of a workflow process or in a where 
information is not readily available.

Pseudo Code

/*====================================================+        
|               Copyright (c) 1999 Oracle Corporation 
|                  Redwood Shores, California, USA 
|                       All rights reserved
+=====================================================*/       
SET VERIFY OFF                                                                       
WHENEVER SQLERROR EXIT FAILURE ROLLBACK;                                             
                                                                                     
CREATE OR REPLACE PACKAGE OKC_MY_ACTION_ASMBLR_PVT AS 
g_pkg_name     CONSTANT varchar2(100) := ’OKC_MY_ACTION_ASMBLR_PVT’;            
                                  
---------------------------------------------------------------------- 
-- PROCEDURE acn_assemble                                                          
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---------------------------------------------------------------------- 
  PROCEDURE acn_assemble( 
/* mandatory parameters do not change */                                             
    p_api_version                  IN NUMBER,                                        
    p_init_msg_list                IN VARCHAR2 DEFAULT OKC_API.G_FALSE,              
    x_return_status                OUT NOCOPY VARCHAR2,                              
    x_msg_count                    OUT NOCOPY NUMBER,                                
    x_msg_data                     OUT NOCOPY VARCHAR2,
/* parameters essential to gather attribute values for this action to be added 
here */                                                                   
    p_my_param                  IN/OUT DATATYPE,
    . . .);                                                                                  
END OKC_MY_ACTION_ASMBLR_PVT;                                                           
/                                                                                    
commit;                                                                              
exit;
                                                                               
/*====================================================+  
|               Copyright (c) 1999 Oracle Corporation 
|                  Redwood Shores, California, USA
|                       All rights reserved.
+=====================================================*/ 
                                                                               
SET VERIFY OFF                                                                 
WHENEVER SQLERROR EXIT FAILURE ROLLBACK;                                       
                                                                           
CREATE OR REPLACE PACKAGE BODY OKC_MY_ACTION_ASMBLR_PVT AS                        
  g_pkg_name     CONSTANT varchar2(100) := ’OKC_MY_ACTION_ASMBLR_PVT’;            
                                                                               
  PROCEDURE acn_assemble( 
/* mandatory parameters do not change */                                             
    p_api_version                  IN NUMBER,                                  
    p_init_msg_list                IN VARCHAR2 DEFAULT OKC_API.G_FALSE,        
    x_return_status                OUT NOCOPY VARCHAR2,                        
    x_msg_count                    OUT NOCOPY NUMBER,                          
    x_msg_data                     OUT NOCOPY VARCHAR2,
 /* parameters essential to gather attribute values for this action to be added 
here */                                                                   
    p_my_param                  IN/OUT DATATYPE
    . . .) IS                               
--                                                                             
    l_api_name            CONSTANT VARCHAR2(30) := ’ACN_ASSEMBLE’;             
    l_api_version         NUMBER := 1.0;                                       
    l_init_msg_list       VARCHAR2(1) DEFAULT OKC_API.G_FALSE;                 
    l_return_status varchar2(1) := OKC_API.G_RET_STS_SUCCESS;                  
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--   
  /*Declare cursor or cursors to gather attribute values using
    p_my_param */                                                                          
    CURSOR my_cur IS                                                            
    SELECT attribute1_value,
           attribute2_value,
           . . .,
           . . .                                                  
    FROM  table1,
          table2,
          . . .                                       
    WHERE table1.id = p_my_param
    AND   . . .;                                    
    my_rec my_cur%ROWTYPE;                                           
    
    /* Declare cursor to get all attributes element_names, format masks(for 
date,number datatypes) for the newly created action*/ 
/* ‘MY_ACTION_CORRELATION’ is the correlation of the new action for
 which this assembler is being coded */  
                                                              
    CURSOR acn_cur IS                                              
    SELECT aae.element_name element_name,                          
           aae.format_mask format_mask                             
    FROM   okc_actions_b acn,                                      
           okc_action_attributes_b aae                             
    WHERE  acn.id = aae.acn_id                                     
    AND    acn.correlation = ‘MY_ACTION_CORRELATION’;                              
    acn_rec acn_cur%ROWTYPE;                                       
                                                                   
--                                                                 
   l_rec okc_aq_pvt.corrid_rec_typ;                                
   l_tbl okc_aq_pvt.msg_tab_typ;                                   
   i     NUMBER := 1;                                                 
--                                                                 
    BEGIN                                                          
    -- call start_activity to create savepoint, check comptability 
    -- and initialize message list                                 
       l_return_status := OKC_API.START_ACTIVITY(l_api_name        
                                                ,l_init_msg_list   
                                                ,’_PVT’            
                                                ,x_return_status   
                                                );                 
    -- check if activity started successfully                      
       IF l_return_status = OKC_API.G_RET_STS_UNEXP_ERROR THEN     
          RAISE OKC_API.G_EXCEPTION_UNEXPECTED_ERROR;              
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       ELSIF l_return_status = OKC_API.G_RET_STS_ERROR THEN        
             RAISE OKC_API.G_EXCEPTION_ERROR;                      
       END IF;                                                     
                                                                   
    l_rec.corrid := ‘MY_ACTION_CORRELATION’;                                       
    l_tbl := okc_aq_pvt.msg_tab_typ();  
                          
  /*   'ATTRIBUTE1_ELEMENT_NAME’ is the ‘element name’ of the action      
  attribute1 for the newly defined action */
                                                                  
    FOR acn_rec IN acn_cur LOOP                                    
      OPEN my_cur;                                                  
      FETCH my_cur INTO my_rec;                                      
        IF acn_rec.element_name = ‘ATTRIBUTE1_ELEMENT_NAME’ THEN                      
          l_tbl.extend;                                            
          l_tbl(i).element_name  :=  acn_rec.element_name;                      
          l_tbl(i).element_value := my_rec.attribute1_value;                            
        ELSIF acn_rec.element_name = ‘ATTRIBUTE2_ELEMENT_NAME’ THEN                          
          l_tbl.extend;                                                       
          l_tbl(i).element_name  :=  acn_rec.element_name;                                
          l_tbl(i).element_value := my_rec.attribute2_value;
 /* If the attribute is of date or number datatype and the datatype is specified 
while defining the attribute then do the following */
        ELSIF acn_rec.element_name = ‘ATTRIBUTE3_ELEMENT_NAME’ THEN          
          l_tbl.extend;                                            
          l_tbl(i).element_name :=  acn_rec.element_name;                
          IF acn_rec.format_mask IS NOT NULL THEN                  
            l_tbl(i).element_value := to_char(my_rec.attribute3_value,   
                                              acn_rec.format_mask);
          ELSE                                                     
            l_tbl(i).element_value := my_rec.attribute3_value;             
          END IF;                                                  
                    
        ELSIF . . .                         
          . . .           
        END IF;                                                               
        i := i+1;                                                             
      CLOSE my_cur;                                                            
    END LOOP; 

/* This procedure puts the message on the events queue */
OKC_aq_pvt.send_message(p_api_version   =>  l_api_version                 
                            ,x_msg_count     => x_msg_count                   
                            ,x_msg_data      => x_msg_data                    
                            ,x_return_status => x_return_status               
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                            ,p_corrid_rec    => l_rec                         
                            ,p_msg_tab       => l_tbl                         
                            ,p_queue_name    => 
                             okc_aq_pvt.g_event_queue_name 
                            );                                                
    -- check if activity started successfully                                 
       IF l_return_status = OKC_API.G_RET_STS_UNEXP_ERROR THEN                
          RAISE OKC_API.G_EXCEPTION_UNEXPECTED_ERROR;                         
       ELSIF l_return_status = OKC_API.G_RET_STS_ERROR THEN                   
          RAISE OKC_API.G_EXCEPTION_ERROR;         
       END IF;                                        
                                                      
    OKC_API.END_ACTIVITY(x_msg_count, x_msg_data);    
                                                      
    EXCEPTION                                         
       WHEN OKC_API.G_EXCEPTION_ERROR THEN            
       x_return_status := OKC_API.HANDLE_EXCEPTIONS   
       (l_api_name,                                   
        G_PKG_NAME,                                   
        ’OKC_API.G_RET_STS_ERROR’,                    
        x_msg_count,                                  
        x_msg_data,                                   
        ’_PVT’);                                      
       WHEN OKC_API.G_EXCEPTION_UNEXPECTED_ERROR THEN 
       x_return_status := OKC_API.HANDLE_EXCEPTIONS   
       (l_api_name,                                   
        G_PKG_NAME,                                   
        ’OKC_API.G_RET_STS_UNEXP_ERROR’,              
        x_msg_count,                                  
        x_msg_data,                                   
        ’_PVT’);                                      
       WHEN OTHERS THEN                               
       x_return_status := OKC_API.HANDLE_EXCEPTIONS   
       (l_api_name,                                   
        G_PKG_NAME,                                   
        ’OTHERS’,                                     
        x_msg_count,                                  
        x_msg_data,                                   
        ’_PVT’);                                      
    END acn_assemble;                                 
                                                      
END OKC_K_MY_ACTION_PVT;                            
/                                                     
commit;                                               
exit;                                                 
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4.2.1.1 Coding Functions for Function Expressions in Condition 
Lines
The functions used in the Function tab of the Conditions window should always return T or 
F as a return value. The following example shows how a function expression can be used to 
determine if a contract belongs to a particular customer. While entering the parameters for 
the function expression in the Conditions window, the user can enter a value instead of 
selecting attributes for parameters p_role and p_customer_name. This way users can check 
if the contract belongs to a customer they are interested in. The condition evaluator executes 
this function with the user entered values at run time and returns T or F, based on which 
certain outcomes can be executed.

FUNCTION customer_exists(p_kid IN NUMBER,                     
                         p_customer_name IN VARCHAR2,         
                         p_role    IN  VARCHAR2)              
RETURN VARCHAR2 IS                                            
                                                              
CURSOR cust_cur IS                                            
select ’X’                                                    
from  okc_k_party_roles_v role,                               
      okx_parties_v party                                     
where role.object1_id1 = party.id1                            
and   role.object1_id2 = party.id2                            
and   role.jtot_object1_code in (’OKX_PARTY’,’OKX_OPERUNIT’)  
and   upper(role.rle_code) = upper(p_role)                    
and   role.chr_id = p_kid                                     
and   party.name = p_customer_name;                           
cust_rec  cust_cur%ROWTYPE;                                   
                                                              
BEGIN                                                         
   OPEN cust_cur;                                             
   FETCH cust_cur INTO cust_rec;                              
     IF cust_cur%FOUND THEN                                   
       RETURN(’T’);                                           
     ELSE                                                     
       RETURN(’F’);                                           
     END IF;                                                  
   CLOSE cust_cur;                                            
EXCEPTION                                                     
  WHEN others THEN                                            
  RETURN(’F’);                                                
END customer_exists;                                          
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4.2.1.2 Coding Outcomes for Conditions
All PL/SQL Outcomes that do not have the standard set of parameters listed below should 
have a wrapper API which provides these parameters and default values. All outcomes 
should have p_init_msg_list set to OKC_API.G_TRUE to initialize message stack.

    p_api_version                  IN NUMBER,                                  

    p_init_msg_list                IN VARCHAR2 DEFAULT OKC_API.G_TRUE,        

    x_return_status                OUT NOCOPY VARCHAR2,                        

    x_msg_count                    OUT NOCOPY NUMBER,                          

    x_msg_data                     OUT NOCOPY VARCHAR2,

If there is a nonstandard OUT parameter in the required outcome - a wrapper API will need 
to be written which includes a local variable where the OUT parameter can be assigned to. 

EXCEPTION                                         
       WHEN OKC_API.G_EXCEPTION_ERROR THEN            
       x_return_status := OKC_API.HANDLE_EXCEPTIONS   
       (l_api_name,                                   
        G_PKG_NAME,                                   
        ’OKC_API.G_RET_STS_ERROR’,                    
        x_msg_count,                                  
        x_msg_data,                                   
        ’_PVT’);                                      
       WHEN OKC_API.G_EXCEPTION_UNEXPECTED_ERROR THEN 
       x_return_status := OKC_API.HANDLE_EXCEPTIONS   
       (l_api_name,                                   
        G_PKG_NAME,                                   
        ’OKC_API.G_RET_STS_UNEXP_ERROR’,              
        x_msg_count,                                  
        x_msg_data,                                   
        ’_PVT’);                                      
       WHEN OTHERS THEN                               
       x_return_status := OKC_API.HANDLE_EXCEPTIONS   

Note, that it is not necessary to define these standard parameters in the Process 
Definitions form, as the Outcome Initiator will always include these parameters in 
the procedure call. The Outcome must not contain any nonstandard OUT 
parameters. If these are included in an outcome it will fail on execution with a 
’PLS-00363: expression ’<expression>’ cannot be used as an assignment target’ 
error. 
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       (l_api_name,                                   
        G_PKG_NAME,                                   
        ’OTHERS’,                                     
        x_msg_count,                                  
        x_msg_data,                                   
        ’_PVT’);                                      
    END;                                 

Any messages specific to the outcome should be created in the FND_NEW_MESSAGES 
table. If the Outcome is a workflow, then it need not have any out parameters. The errors in 
workflow will be handled by standard workflow functionality.

4.2.2 Coding Date Based Action Assemblers
Users can define actions that are not triggered by originating actions, but are related to a 
certain point in time, such as the date when contracts are about to expire, or a customer’s 
anniversary date within the specified period, and so on. To process all the date based actions, 
a concurrent manager is scheduled to run once everyday to run the concurrent program 
"Date Assembler" which checks for all records that satisfy the date condition and builds a 
message table with all the attributes and values which is put on the queue for evaluation. 

Following is an example to code a date based action assembler for contracts that are about to 
expire.

n All these actions need to be defined along with correlation ex: KEXPIRE and attributes 
that can be derived from the information provided by the action, such as condition 
header id, contract category, contract class, contract expiry date, contract id, contract 
number, contract number modifier, contract status, estimated amount, and so on using 
the Define Action form.

n Using the Define Condition form you define whether the event is a date based event. 
The exact point in time must be indicated: For example “45 days before contract 
expiration date”.

Refer to Oracle Applications Developer’s Guide for information on Concurrent programs. 
The Concurrent program date assembler scheduled to run once everyday selects a contract or 
all contracts (for independent conditions) expiring before or after the given number of days 
from the current date.

Pseudo Code

Date action assembler pub
/*===============================================================+ Copyright (c) 
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1999 Oracle Corporation                                                                               
Redwood Shores, California, USA
All rights reserved. 
+===============================================================*/  
SET VERIFY OFF 
WHENEVER SQLERROR EXIT FAILURE ROLLBACK; 
CREATE OR REPLACE PACKAGE BODY MY_DATE_ASMBLR_PUB AS 
PROCEDURE conc_mgr(errbuf  OUT VARCHAR2,
                                           retcode OUT VARCHAR2) IS

  l_api_name        CONSTANT VARCHAR2(30) := ’conc_mgr’;
  l_api_version     CONSTANT VARCHAR2(30) := 1.0;
  l_return_status   VARCHAR2(1)  := OKC_API.G_RET_STS_SUCCESS;
  x_return_status   VARCHAR2(1)  := OKC_API.G_RET_STS_SUCCESS;
  l_msg_count       NUMBER;
  l_msg_data        VARCHAR2(1000);
  l_init_msg_list   VARCHAR2(3) := ’F’;

  BEGIN
       -- call start_activity to create savepoint, check comptability 
       -- and initialize message list
       l_return_status := OKC_API.START_ACTIVITY(l_api_name
                                                ,l_init_msg_list
                                                ,’_PUB’
                                                ,x_return_status
                                                );
    --Initialize the return code
    retcode := 0;
MY_DATE_ASMBLR_PUB.date_expire_asmblr(
           p_api_version    => l_api_version
                 ,p_init_msg_list  => l_init_msg_list
                 ,x_return_status  => l_return_status
                 ,x_msg_count     => l_msg_count  
          ,x_msg_data       => l_msg_data);

IF l_return_status = OKC_API.G_RET_STS_UNEXP_ERROR THEN
RAISE OKC_API.G_EXCEPTION_UNEXPECTED_ERROR;
ELSIF l_return_status = OKC_API.G_RET_STS_ERROR THEN
RAISE OKC_API.G_EXCEPTION_ERROR;
ELSIF l_return_status = OKC_API.G_RET_STS_SUCCESS THEN
                commit;
       END IF;
OKC_API.END_ACTIVITY(l_msg_count, l_msg_data); 
EXCEPTION
     WHEN OKC_API.G_EXCEPTION_ERROR THEN
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              retcode := 2;
               errbuf  := substr(sqlerrm,1,200);
       l_return_status := OKC_API.HANDLE_EXCEPTIONS
       (l_api_name,
        G_PKG_NAME,
        ’OKC_API.G_RET_STS_ERROR’,
        l_msg_count,
        l_msg_data,
        ’_PUB’);
       WHEN OKC_API.G_EXCEPTION_UNEXPECTED_ERROR THEN
retcode := 2;
errbuf  := substr(sqlerrm,1,200);
       l_return_status := OKC_API.HANDLE_EXCEPTIONS
       (l_api_name,
        G_PKG_NAME,
        ’OKC_API.G_RET_STS_UNEXP_ERROR’,
        l_msg_count,
        l_msg_data,
        ’_PUB’);
       WHEN OTHERS THEN
retcode := 2;
errbuf  := substr(sqlerrm,1,200);
       l_return_status := OKC_API.HANDLE_EXCEPTIONS
       (l_api_name,
        G_PKG_NAME,
        ’OTHERS’,
        l_msg_count,
        l_msg_data,
        ’_PUB’);
  END conc_mgr;

  PROCEDURE date_expire_asmblr(                                                   
    p_api_version                  IN NUMBER DEFAULT 1.0,                      
    p_init_msg_list                IN VARCHAR2 DEFAULT OKC_API.G_FALSE,         
    x_return_status                OUT NOCOPY VARCHAR2,                         
    x_msg_count                    OUT NOCOPY NUMBER,                           
    x_msg_data                     OUT NOCOPY VARCHAR2) IS                   
    
    l_api_name            CONSTANT VARCHAR2(30) := ’date_assemble’;
    l_return_status       VARCHAR2(1) := OKC_API.G_RET_STS_SUCCESS;                             

    --Get all the action and condition details for a date based event
    CURSOR acn_csr IS
    SELECT acn.correlation, 
           acn.acn_type, 
Customizing Oracle Contracts Core 4-15



Customizing Events
           cnh.id, 
           cnh.dnz_chr_id, 
           cnh.cnh_variance, 
           cnh.before_after
    FROM okc_condition_headers_v cnh, 
         okc_actions_v acn
    WHERE cnh.acn_id = acn.id
    AND acn.acn_type = ’DBA’
    AND cnh.condition_valid_yn = ’Y’
    AND cnh.template_yn = ’N’;
    
    acn_recacn_csr%ROWTYPE;
    
    BEGIN
    -- call start_activity to create savepoint, check comptability 
    -- and initialize message list
       l_return_status := OKC_API.START_ACTIVITY(l_api_name
                                                ,p_init_msg_list
                                                ,’_PUB’
                                                ,x_return_status
                                                );
       -- check if activity started successfully
       IF l_return_status = OKC_API.G_RET_STS_UNEXP_ERROR THEN
          RAISE OKC_API.G_EXCEPTION_UNEXPECTED_ERROR;
       ELSIF l_return_status = OKC_API.G_RET_STS_ERROR THEN
             RAISE OKC_API.G_EXCEPTION_ERROR;
       END IF; 
   
--If the action type is date based action and the correlation is Contract            
expiry date
--then call the date action assembler to process all the contracts expiring 
before or after
--the given number of days
       FOR acn_rec IN acn_csr LOOP
             IF acn_rec.acn_type = ’DBA’ and acn_rec.correlation = ’KEXPIRE’ 
THEN
--Call the date assembler for contract expiry date
    MY_EXP_DATE_ASMBLR_PVT.contract_exp_date_asmblr(
              p_api_version   => 1   
                 ,p_init_msg_list        => ’F’        
                 ,x_return_status        => x_return_status
                 ,x_msg_count           => x_msg_count  
                 ,x_msg_data             => x_msg_data
                 ,p_cnh_id                 => acn_rec.id
                 ,p_dnz_chr_id          => acn_rec.dnz_chr_id   
4-16 Oracle Contracts Core Concepts and Procedures



Customizing Events
                 ,p_cnh_variance       => acn_rec.cnh_variance
                 ,p_before_after         => acn_rec.before_after);
       IF x_return_status = OKC_API.G_RET_STS_UNEXP_ERROR THEN
          RAISE OKC_API.G_EXCEPTION_UNEXPECTED_ERROR;
       ELSIF x_return_status = OKC_API.G_RET_STS_ERROR THEN
RAISE OKC_API.G_EXCEPTION_ERROR;
ELSIF x_return_status = OKC_API.G_RET_STS_SUCCESS THEN
commit;
       END IF; 
ELSIF  acn_rec.acn_type = ‘DBA’ and acn_rec.correlation = ‘CORRELATION’ THEN
--Call the  date assembler for --------------------
  END IF; 
      END LOOP;
    OKC_API.END_ACTIVITY(x_msg_count, x_msg_data);

    EXCEPTION
       WHEN OKC_API.G_EXCEPTION_ERROR THEN
       x_return_status := OKC_API.HANDLE_EXCEPTIONS
       (l_api_name,
        G_PKG_NAME,
        'OKC_API.G_RET_STS_ERROR',
        x_msg_count,
        x_msg_data,
        '_PUB');
       WHEN OKC_API.G_EXCEPTION_UNEXPECTED_ERROR THEN
       x_return_status := OKC_API.HANDLE_EXCEPTIONS
       (l_api_name,
        G_PKG_NAME,
        'OKC_API.G_RET_STS_UNEXP_ERROR',
        x_msg_count,
        x_msg_data,
        '_PUB');
       WHEN OTHERS THEN
       x_return_status := OKC_API.HANDLE_EXCEPTIONS
       (l_api_name,
        G_PKG_NAME,
        'OTHERS',
        x_msg_count,
        x_msg_data,
        '_PUB');
    END date_expire_asmblr;
END MY_DATE_ASMBLR_PUB;
/
commit;
exit;
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Date Action Assembler
For coding MY_EXP_DATE_ASMBLR_PVT Refer to Coding Action assemblers, example 
2 when attribute information needs to be assembled. 

/*=================================================================+
|               Copyright (c) 1999 Oracle Corporation                                                                        
|                  Redwood Shores, California, USA                                                                            
|                       All rights reserved.                                                                                               
+=================================================================*/ 
                                                                                                                                             
SET VERIFY OFF                                                                  
                                                                                
WHENEVER SQLERROR EXIT FAILURE ROLLBACK;                                        
                                                                                
CREATE OR REPLACE PACKAGE BODY MY_EXP_DATE_ASMBLR_PVT AS     

  PROCEDURE date_assemble(
    p_api_versionIN NUMBER,
    p_init_msg_list     IN VARCHAR2 DEFAULT OKC_API.G_FALSE,
    x_return_status     OUT NOCOPY VARCHAR2,
    x_msg_count         OUT NOCOPY NUMBER,
    x_msg_data          OUT NOCOPY VARCHAR2,
    p_cnh_id               IN NUMBER,          
    p_dnz_chr_id        IN IN NUMBER,
    p_cnh_variance     IN IN NUMBER,
    p_before_after       IN VARCHAR2) IS
        
      
    l_api_name            CONSTANT VARCHAR2(30) := ’date_assemble’;
    l_return_status       VARCHAR2(1) := OKC_API.G_RET_STS_SUCCESS;
    k                     NUMBER := 1;                                  
    l_last_rundate DATE;
    l_variance                 okc_condition_headers_b.cnh_variance%TYPE;
    l_corrid_rec      okc_aq_pub.corrid_rec_typ; 
    l_msg_tbl         okc_aq_pub.msg_tab_typ;
   
    --Get the last rundate of the date assembler concurrent program 
    CURSOR last_rundate_csr IS
    SELECT nvl(max(req.actual_completion_date), (sysdate - 1)) last_rundate
    FROM   fnd_concurrent_programs prg,fnd_concurrent_requests req
    WHERE  prg.application_id = req.program_application_id
    AND    prg.concurrent_program_id = req.concurrent_program_id
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    AND    prg.concurrent_program_name = ’CONCURRENT_PROGRAM_NAME’ 
    AND    req.status_code <> ’E’;

    --Get all the contracts that are expiring from the last rundate 
    --of the date assembler concurrent program for a given condition
    CURSOR attribute_value_csr(p_chr_id IN NUMBER, p_variance IN NUMBER, p_last_
rundate IN DATE) is
    SELECT a.attr_value1,
           a.attr_value2,
           a.attr_value3,
               -------------
    FROM   table1 a, table2 b
    WHERE (a.id = p_chr_id OR p_chr_id IS NULL)
    AND -------------------------------
    AND trunc(a.end_date) BETWEEN
    (p_variance + trunc(p_last_rundate) + 1)
    AND (trunc(sysdate) + p_variance);

    CURSOR elements_csr IS
    SELECT aae.element_name
    FROM   okc_actions_v acn,okc_action_attributes_v aae
    WHERE  acn.id = aae.acn_id
    AND    acn.correlation = ’CORRELATION_NAME’; 

    elements_rec elements_csr%ROWTYPE;
                                      
    BEGIN
    -- call start_activity to create savepoint, check comptability 
    -- and initialize message list
       l_return_status := OKC_API.START_ACTIVITY(l_api_name
                                                ,p_init_msg_list
                                                ,’_PVT’
                                                ,x_return_status
                                                );
    -- check if activity started successfully
       IF l_return_status = OKC_API.G_RET_STS_UNEXP_ERROR THEN
          RAISE OKC_API.G_EXCEPTION_UNEXPECTED_ERROR;
       ELSIF l_return_status = OKC_API.G_RET_STS_ERROR THEN
             RAISE OKC_API.G_EXCEPTION_ERROR;
       END IF; 

    --Get the correlation
    SELECT acn.correlation INTO l_corrid_rec FROM okc_actions_v acn 
    WHERE acn.correlation = ’CORRELATION_NAME’;
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    --Fetch the last rundate of the date assembler concurrent program
    OPEN last_rundate_csr;
    FETCH last_rundate_csr into l_last_rundate;
    CLOSE last_rundate_csr;

        --Check if the variance is positive or negative
IF p_before_after = ’A’ THEN
l_variance := p_cnh_variance * -1;
ELSIF p_before_after = ’B’ THEN
l_variance := p_cnh_variance;
END IF;             
                                                                                    
      --get contract details
      FOR attribute_value_rec in attribute_value_csr(p_chr_id       => p_dnz_
chr_id, 
                           p_variance     => l_variance, 
                           p_last_rundate => l_last_rundate) LOOP
           k := 1; 
   l_contract_number := k1_rec.k_number;
   --Initialize the table
   l_msg_tbl   := okc_aq_pvt.msg_tab_typ();
           FOR elements_rec IN elements_csr LOOP
--Build the elements table          
    IF elements_rec.element_name = ’ATTRIBUTE1_ELEMENT_NAME’ THEN   
    l_msg_tbl.extend;
       l_msg_tbl(k).element_name  := elements_rec.element_name;                   
       l_msg_tbl(k).element_value := attribute_value_rec.attr_val1;                
    ELSIF elements_rec.element_name = ’ATTRIBUTE2_ELEMENT_NAME’ THEN                             
    l_msg_tbl.extend;
       l_msg_tbl(k).element_name  := elements_rec.element_name;                   
       l_msg_tbl(k).element_value := attribute_value_rec.attr_val2;           
    ELSIF elements_rec.element_name = ’ATTRIBUTE3_ELEMENT_NAME’ THEN                             
    l_msg_tbl.extend;
       l_msg_tbl(k).element_name  := elements_rec.element_name;                   
       l_msg_tbl(k).element_value := attribute_value_rec.attr_val3;              
    ELSIF -------------------------------------------------------------
   --Increment the counter
k := k + 1;  
END LOOP; 

--Call the Advanced queue procedure to put the message on the queue
OKC_AQ_PUB.send_message(p_api_version      =>’1.0’
              ,p_init_msg_list    => ’F’
                                       ,x_msg_count       => x_msg_count
                                     ,x_msg_data         => x_msg_data
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                                     ,x_return_status    => l_return_status
                                     ,p_corrid_rec        => l_corrid_rec
                                   ,p_msg_tab           => l_msg_tbl
                                    ,p_queue_name     => okc_aq_pvt.g_event_
queue_name);
IF l_return_status = OKC_API.G_RET_STS_UNEXP_ERROR THEN
          RAISE OKC_API.G_EXCEPTION_UNEXPECTED_ERROR;
      ELSIF l_return_status = OKC_API.G_RET_STS_ERROR THEN
             RAISE OKC_API.G_EXCEPTION_ERROR;
ELSIF l_return_status = OKC_API.G_RET_STS_SUCCESS THEN
commit;
       END IF;                                    
    END LOOP;

    OKC_API.END_ACTIVITY(x_msg_count, x_msg_data);

    EXCEPTION
       WHEN OKC_API.G_EXCEPTION_ERROR THEN
       x_return_status := OKC_API.HANDLE_EXCEPTIONS
       (l_api_name,
        G_PKG_NAME,
        ’OKC_API.G_RET_STS_ERROR’,
        x_msg_count,
        x_msg_data,
        ’_PVT’);
       WHEN OKC_API.G_EXCEPTION_UNEXPECTED_ERROR THEN
       x_return_status := OKC_API.HANDLE_EXCEPTIONS
       (l_api_name,
        G_PKG_NAME,
        ’OKC_API.G_RET_STS_UNEXP_ERROR’,
        x_msg_count,
        x_msg_data,
        ’_PVT’);
       WHEN OTHERS THEN
       x_return_status := OKC_API.HANDLE_EXCEPTIONS
       (l_api_name,
        G_PKG_NAME,
        ’OTHERS’,
        x_msg_count,
        x_msg_data,
        ’_PVT’);
    END date_assemble;

END MY_EXP_DATE_ASMBLR_PVT;
/
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commit;
exit;

4.2.3 Rules For Creating Actions
1. All Actions defined should have at least one attribute.

2. Counter based Actions should have COUNTER_GROUP_ID and COUNTER_
GROUP_LOG_ID as mandatory attributes.

4.3 Customizing Workflows
Oracle Workflow enables you to automate business processes, routing information of any 
type according to business rules. Workflow automates two procedures in Oracle Contracts:

n Customizing approval workflow

n Contracts change requests workflow

You can use Oracle Workflow Builder to customize the two workflows.

4.3.1 Customizing Approval Workflow
The Approval Workflow OKCAUKAP is using the process: K_APPROVAL_PROCESS.

The default approval workflow routes the approval to the user SYSADMIN, see Setting up 
the Approval Process. After the user SYSADMIN has approved the workflow, the initiator 
of the workflow receives a notification to sign the contract. 

The recommendation is to modify the workflow, so that after the last approval is obtained, 
the signature is requested. After the contract is signed, it may get the status Active or 
Signed, depending on the effectivity dates of the contract.

4.3.2 Customizing Change Requests Workflow
The Change Request Workflow OKCADCRQ is using the process: CHK_APPROVAL_
PROCESS. The default approval workflow routes the approval to the user SYSADMIN, see 
Setting up the Approval Process.

4.4 Registering a New Source as a JTF Object
Oracle Contracts Core allows you to define your own list of values in several forms. These 
list of values are called sources. You then can use these sources when defining Line Style 
sources or Role Sources.
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The process of making any kind of data available as sources comprises three steps:

1. Defining a view.

2. Integrating the view into as a JTF object.

3. Assigning the usage, that is should this source be used for line style definitions, role 
definitions, and so on.

To explain how to register a new source as a JTF object, an example will be shown. Assume 
that you need a line style source that qualifies frequencies:

4.4.1 Defining a View
To define a view that can be integrated into a JTF object, the view must have the format 
outlined below:

 Name                                     Null         Type

 --------------------------------- --------------- ------------------------

 ID1                                         NOT NULL    NUMBER

 ID2                                         NOT NULL    NUMBER

 NAME                                   NOT NULL    VARCHAR2(11)

 DESCRIPTION                     NOT NULL    VARCHAR2(31)

 PRIMARY_UOM_CODE  NOT NULL     VARCHAR2(0)

 STATUS                               NOT NULL     CHAR(1)

 START_DATE_ACTIVE                                 DATE

 END_DATE_ACTIVE                                      DATE

Value Description

Never Never

Seldom 1 to 4 times

Often Ranging from 5 to not always

Always Without a doubt, always happens
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ID1 and ID2 ensure the uniqueness of the rows. If ID1 is selective enough to be unique, you 
can fill in a dummy character like ‘#’ as ID2.

To define the view OKX_FREQ_V, following the mandatory format, run the following 
script:

CREATE OR REPLACE VIEW okx_freq_v AS
SELECT 1 ID1, ’#’ ID2, ’Often’ NAME, ’ranging from 5 to not always’ DESCRIPTION,
’A’ STATUS, sysdate START_DATE_ACTIVE, sysdate END_DATE_ACTIVE,
null PRIMARY_UOM_CODE
FROM DUAL
UNION SELECT 2 ID1, ’#’ ID2, ’Never’ NAME, ’Never’ DESCRIPTION,
’A’ STATUS, sysdate START_DATE_ACTIVE, sysdate END_DATE_ACTIVE,
null PRIMARY_UOM_CODE
FROM DUAL
UNION SELECT 3 ID1, ’#’ ID2, ’Hardly ever’ NAME, ’1 to 4 times’ DESCRIPTION,
’A’ STATUS, sysdate START_DATE_ACTIVE, sysdate END_DATE_ACTIVE,
null PRIMARY_UOM_CODE
FROM DUAL
UNION SELECT 4 ID1, ’#’ ID2, ’Always’ NAME,
’Without a doubt, always happens’ DESCRIPTION,
’A’ STATUS, sysdate START_DATE_ACTIVE, sysdate END_DATE_ACTIVE,
null PRIMARY_UOM_CODE
FROM DUAL

4.4.2 Integrating the View as a JTF Object
Use the ‘CRM Task Manager’ responsibility to integrate the view. 

Open the Form: Task Setup: Object Types through the menu Setup: Objects Metadata.

1. Enter a name and description.

2. Enter a unique object code, which will be used for internal identification, in this 
example: OKX_FREQ.

Note: For line items, you need the column primary_uom_code only if you 
want to price the line. 

Note: You should consult the JTF user manuals to find out more about the 
fields of the form. However, this section gives you an example for the typical 
case of registering a view as a JTF object.
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3. Enter a start date.

4. In the ‘Select Statement Details’ section, enter two values, separated by a blank into the 
FROM field:

n The name of the view (i.e. OKX_FREQ_V)

n The name of the object code (i.e. OKX_FREQ)

5. In the order by field, enter the object code name and column name you want to order by, 
(i.e. OKX_FREQ.name).

4.4.3 Assigning the Usage
In the Form: Task Setup: Object Types you now can assign usages. The following usages 
have been defined for Oracle Contracts Core:

Field Field Values

Name Frequency

Description Frequency in non quantitative terms

Start Date Today’s date

Object Code OKX_FREQ

From (in the Select Statement Details) OKX_FREQ_V_OKX_FREQ

Order by (in the Select Statement Details) OKX_FREQ.name

Object User Description

OK Contracts

OKX Contract source

OKX_B_O_ROLE Object constrained for buy

OKX_B_S_ROLE Subject constrained for buy

OKX_CONTACTS Contract contact source

OKX_CURRENCY Constraint by currency

OKX_LINES Contract line style source

OKX_ROLES Contract role source
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If you want include your new List of Values in the linestyles, you have to register the line 
style as an object user. Enter the OKX_LINES as the object user.

OKX_RULES Contract rule source

OKX_S_O_ROLE Object constrained for sell

OKX_S_S_ROLE Subject constrained for sell

Note: Despite the fact that you can add more Object users, adding Object 
users beyond the users listed here will not benefit you. Only the seeded 
values support the standard forms and functionalities.

Object User Description
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